
Bandit Bander Reference Guide

Kevin Laurent
Rita Malorodova

Mike Elms
Jerry McFaul



Bandit Bander Reference Guide
by Kevin Laurent, Rita Malorodova, Mike Elms, and Jerry McFaul

Version 2.01, 2008-04-16



iii

Table of Contents
1. Introduction to Bandit ......................................................................................................  1

1.1. Welcome ............................................................................................................  1
1.1.1. Features of Bandit ......................................................................................  1
1.1.2. Using Bandit .............................................................................................  1

2. Installing Bandit .............................................................................................................  3
2.1. System Requirements ............................................................................................  3

2.1.1. Windows ..................................................................................................  3
2.1.2. Macintosh .................................................................................................  3

2.2. Obtaining the Software ..........................................................................................  3
2.3. Installation ..........................................................................................................  4

2.3.1. Installing on Windows ................................................................................  4
2.3.2. Installing on Macintosh OS X ......................................................................  4
2.3.3. Upgrading from an Earlier Version of Bandit ..................................................  5

2.4. Running Bandit ....................................................................................................  5
2.4.1. Bandit Opening Screen ...............................................................................  5
2.4.2. Getting Around .......................................................................................... 7

2.5. Creating and Using the Bandit Backup File ...............................................................  8
2.5.1. Creating a Backup File ...............................................................................  8
2.5.2. Restoring from a Backup File ......................................................................  8

3. Bandit Settings ...............................................................................................................  9
3.1. Bander Info .......................................................................................................  10
3.2. Data Entry .........................................................................................................  10
3.3. Band Edits ......................................................................................................... 11
3.4. Locations ..........................................................................................................  12

3.4.1. Entering Locations with 10-Minute Block Precision ........................................  13
3.4.2. Entering Locations with 1-Minute Block Precision .......................................... 14
3.4.3. Entering Locations with Exact Precision .......................................................  15

3.5. Wing & Weight .................................................................................................. 15
3.6. User-defined Fields .............................................................................................  16
3.7. Other Settings ....................................................................................................  16

4. Band Inventory .............................................................................................................  17
5. Banding with Bandit ......................................................................................................  20

5.1. Bands Screen—Table View ..................................................................................  21
5.1.1. Resizing and Repositioning Columns ...........................................................  21
5.1.2. Sorting Columns ......................................................................................  21
5.1.3. Entering Banding Data in Table View ..........................................................  21

5.2. Bands Screen—Details View ................................................................................  22
5.2.1. Using the Navigation Panel ........................................................................  23
5.2.2. Entering Auxiliary Marker Data ..................................................................  23
5.2.3. Entering Data for Double Banded Birds ........................................................ 25
5.2.4. Recording Recaptures ................................................................................ 25

5.3. Error Checking ...................................................................................................  26
5.4. Using the Remarks Field ......................................................................................  26
5.5. User-defined Fields .............................................................................................  26
5.6. Other Features of the Bands Screens ......................................................................  27

5.6.1. Filtering Banding Data ..............................................................................  27
5.6.2. Fill-down Feature .....................................................................................  28
5.6.3. Duplicating Banding Records .....................................................................  28
5.6.4. Clearing Banding Data ..............................................................................  29
5.6.5. Submitting Banding Data ...........................................................................  29
5.6.6. Importing Banding Data ............................................................................  30



Bandit Bander Reference Guide

iv

5.6.7. Exporting Banding Data ............................................................................  30
5.6.8. Reports ...................................................................................................  30

6. Recaptures ...................................................................................................................  31
7. Data Submission ...........................................................................................................  32

7.1. The Data Submission Process ...............................................................................  32
8. Find Mode ...................................................................................................................  36
9. Reports ........................................................................................................................  38
10. Reference Tables .........................................................................................................  40
11. Importing and Exporting ...............................................................................................  42

11.1. Importing from Band Manager ............................................................................  42
11.1.1. Importing Band Inventory from Band Manager ............................................  42
11.1.2. Importing Locations from Band Manager ....................................................  43
11.1.3. Importing Bander Information from Band Manager .......................................  43
11.1.4. Importing Banding Records from Band Manager ..........................................  43

11.2. Importing from Other Sources .............................................................................  44
11.3. Exporting from Bandit .......................................................................................  46

11.3.1. Exporting Bands, Band Inventory, Banders, Locations and Recapture Records
.......................................................................................................................  46
11.3.2. Exporting Reference Tables ......................................................................  46

A. Tips and Shortcuts ........................................................................................................  47
B. Bandit Band Record ......................................................................................................  48
C. Data Editing Error Messages ..........................................................................................  51
D. Alert Messages ............................................................................................................  55
E. Frequently Asked Questions about Bandit .........................................................................  58
F. Release Notes ...............................................................................................................  59

F.1. Version 2.0 (released 3/7/2008) .............................................................................  59



v

List of Figures
2.1. Bandit Opening Screen ..................................................................................................  6
2.2. Bandit Screen Layout ....................................................................................................  7
3.1. Bandit Bander Info Settings Screen .................................................................................  9
3.2. Settings Screen—Data Entry Tab ...................................................................................  11
3.3. Bandit Locations Settings Screen ...................................................................................  12
3.4. Bandit User-defined Fields Settings Screen ...................................................................... 16
4.1. Bandit Band Inventory Screen .......................................................................................  17
4.2. Add to Inventory Screen ..............................................................................................  18
5.1. Bandit Bands Table View Screen ..................................................................................  20
5.2. Bandit Band Details View Screen ..................................................................................  23
5.3. Aux Marker tab on the Bands Screen—Details View .........................................................  24
5.4. Aux Marker for a Sequence of Uncoded Colored Bands .....................................................  25
5.5. User Fields tab on the Bands Screen—Details View ..........................................................  27
5.6. Bands Screen Records Menu ........................................................................................  29
7.1. Banding Data to be Submitted Report ............................................................................  33
7.2. Bandit Data Submission Dialog Box ..............................................................................  33
7.3. Bandit Data Submission Email ......................................................................................  34
7.4. Note For Submission File Report ...................................................................................  35
8.1. Bandit Mode Icon Bar .................................................................................................  36
8.2. Find Mode Symbols Drop-down Menu ...........................................................................  37
9.1. Bands Screen with Reports Drop-down ...........................................................................  38
10.1. Bandit Reference Tables Screen ...................................................................................  40
11.1. Import Data from File ................................................................................................  44
11.2. Import Field Mapping Screen ......................................................................................  45



1

Chapter 1. Introduction to Bandit
1.1. Welcome

Bandit is the latest in a long series of programs aimed at helping bird banders manage and submit their data
for large or small numbers of banded birds. Bandit—The Information Manager for Banding Operations,
was created by the Bird Banding Laboratory (BBL) at the U. S. Geological Survey Patuxent Wildlife
Research Center, Laurel, Maryland.

1.1.1. Features of Bandit
The principal use of Bandit is to store data obtained during banding operations and facilitate the transfer
of banding data to the BBL and the Canadian Bird Banding Office (BBO). Bandit allows the bander to
enter and edit data associated with bands obtained from the BBL/BBO as well as data for recaptured birds,
including those banded with bands not in the band inventory within Bandit. To submit banding data to
the BBL/BBO, Bandit includes the ability to email the banding data directly, provided that the computer
running Bandit is connected to the Internet.

Other major features of Bandit are itemized below:

• Data entry and editing can be performed via either a spreadsheet-like table interface or via a record-
by-record form-based interface. The user can switch back and forth between the two interfaces just by
clicking a button.

• Ability to enter data in an extensive list of fields, including the traditional fields (Species, Age, Sex,
Banding Date, Banding Location, Bander ID, etc.) and a wide variety of other fields (how aged/sexed,
extensive measurements, auxiliary markings, tests performed, molt/parasites observed, etc.) A list of
the most important fields in the banding record can be found in Appendix B, Bandit Band Record.

• Pervasive error avoidance, error checking and feedback. Most of the fields in Bandit have an auto-
complete which checks against a list of predefined values. Where appropriate, you can also add your own
values to these lists. Range checking, cross field validation, and location-based checking are included.

• Extensive export capabilities. All of the data contained in Bandit, including all of the lookup tables, can
be exported to a variety of other formats, including Excel, tab-delimited text, comma-delimited text,
DBF, HTML, and XML.

• Banding location coordinates may be entered precisely, including degrees, minutes, and seconds, and
country, state/province, and county names.

• Data submission to the BBL/BBO can be done via an email link built into the program, provided
the computer running Bandit is connected to the internet. The data submission can contain both new
bandings and modifications made to banding records previously submitted.

1.1.2. Using Bandit
The basic guiding principle in Bandit is simple. We have tried to make the process of maintaining a series
of banding records as simple as possible. The road forward is meant to be easy.

1. Install the program. First install the program onto your computer. You can just double click the
installer program that you received and follow the instructions contained in the installer. More detailed
instructions on the installation process can be found in Chapter 2, Installing Bandit.
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2. Run the program. On the PC, select the program from the Start menu, in the program group named
Bandit. On the Mac, select the program from the Applications folder. You may want to drag the icon
to your dock so it is available there. On the opening screen, follow the steps labelled 1, 2, 3. Step 1 will
take you to a screen where you can enter information about your permit and banders, the locations where
you are banding, and some other preferences on how you want to use the program. To get back to the
opening screen, click the word Bandit at the top of the screen. Step 2 will allow you to build an inventory
of the bands you received from the BBL/BBO. Click Bandit to get back to the opening screen. Step 3
is for entering your banding information. You can switch back and forth between Table and Details
data entry modes by clicking either Table or Details. More details on the Settings part of the program
may be found in Chapter 3, Bandit Settings. Details on accessing and updating the Banding Inventory
maintained by Bandit, including how to add bands into the Inventory, may be found in Chapter 4, Band
Inventory. Likewise, Chapter 5, Banding with Bandit, contains more information on the details of using
Bandit to store the data associated with banding operations.

3. Submit your data to the BBL/BBO by clicking on the Submit Data button on the Bands screen. A file will
be created of any bands without errors (or with errors bypassed) you have added or modified since the
last time you submitted data. An email with this file contained as an attachment will automatically be
generated and will appear in your computer’s email program. More information on the data submission
process is available in Chapter 7, Data Submission.

4. Reports are available from the Bands table and details screens. Select the report you want from the
drop-down menu and click the Show/Print Report button. Reports can be sent directly to the printer and
saved in either Excel or PDF format. See Chapter 9, Reports, for more information.

5. Bandit contains a variety of other features. More information on the reference tables contained in Bandit
can be found in Chapter 10, Reference Tables. Methods for importing data into Bandit and exporting
data from Bandit are in Chapter 11, Importing and Exporting.
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Chapter 2. Installing Bandit
The Bandit software needs to be installed onto your computer for it to work. This chapter provides
additional instructions for doing the installation.

2.1. System Requirements
Bandit has advanced features that require a computer equipped with either Windows or Macintosh
operating system.

2.1.1. Windows
• Operating System: Windows 2000, Windows XP, Windows Vista.

• Memory: Minimum 256MB RAM (Minimum 512MB RAM for Windows Vista).

• Disk Space: Minimum 100MB free.

2.1.2. Macintosh
• Operating System: Macintosh OS X 10.3.9, or later.

• Memory: Minimum 256MB RAM.

• Disk Space: Minimum 100MB free.

2.2. Obtaining the Software
The first step in getting Bandit installed on your machine is obtaining the software. You may
download it from the Bird Banding Lab website, http://www.pwrc.usgs.gov/BBL/resources/bandit/
Software/index.html. Make sure you have downloaded the appropriate version for your operating system.
If you cannot download from the web, you can request a copy of the CD ROM from the Bird Banding Lab.
If you received the software on a CD ROM from the Bird Banding Lab, insert the CD ROM into your CD
drive and follow the installation instructions contained on the CD ROM.

Note

Bandit 2.0 is available in four versions:

Version Operating System 

Bandit_2.01.zip Windows XP, Windows Vista

Bandit_2.01_for_win2000.zip Windows 2000

MacBandit_2.01_for_OSX10.4.bin Macintosh OS X 10.4.8, Macintosh OS X
10.5.x

MacBandit_2.01_for_OSX10.3.bin Macintosh OS X 10.3.9 to OS X 10.4.7

Please note that the version for Windows 2000 and Macintosh OS X 10.3 are missing some
of the features present in the versions for Windows XP, Windows Vista, Macintosh OS
X 10.4.8, and Macintosh OS X 10.5.x. Notably absent is the capability to highlight errors
onscreen and on reports. At present, we will maintain versions for these older operating
systems, but we urge users to upgrade to newer operating systems as soon as it is feasible.

http://www.pwrc.usgs.gov/BBL/resources/bandit/Software/index.html
http://www.pwrc.usgs.gov/BBL/resources/bandit/Software/index.html
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2.3. Installation
Bandit comes with an installer program that will guide you through the installation of the program onto
your computer.

2.3.1. Installing on Windows
If you need administrative access to install programs on your computer, you should request that the
installation be performed by your system administrator. Double-click the installer to begin the process.
The installer will ask where you want to install the program. The default is inside the Program Files
folder on your computer. You can install the program somewhere else if you have limited space on your
default hard drive. Click Next to go to the next screen.

The installer will put the program into a folder available under your Start menu. The default name for this
folder is Bandit. You can give it a different name here. Click Next to go to the next screen.

You can have the installer create icons on the Desktop or in the Quick Launch bar at the bottom of the
screen so you can get to the program without having to go back to the Start menu. If you want these icons,
check the appropriate boxes. Then click Next to go to the next screen.

The program will show you a summary of the installation to make sure you want to proceed. Click the
Install button to continue with the installation.

Note

You will also be given the opportunity of installing a utility program called PDFCreator.
PDFCreator is used by Bandit to enable saving reports in Adobe Portable Document Format.
This is useful for saving your reports for later viewing or for emailing the report to someone
else. If you do not install PDFCreator, Bandit will not be able to save reports in PDF format.

The installer will extract all of the files and store them on your computer. Finally, you will see a screen
indicating the installation was successful and asking you if you want to run Bandit. Click Finish to launch
the program.

2.3.2. Installing on Macintosh OS X
You may need to know the name and password of a user that has administrative privileges on your
computer. If this is your own machine, it is just your regular login name and password. If you don’t know
the name and password of a user with administrative privileges on your computer, you should request that
the installation be performed by your system administrator. Alternatively, you can avoid this requirement
by installing the software in a location other than the Applications folder.

If you downloaded the software directly from the BBL, first change the file extension on the Bandit installer
file from .bin to .dmg. Click directly on the name under the icon and type .dmg instead of .bin. The icon
will change to allow you to open the file. Double-click the icon and the system will check the disk image,
then open a new window showing the contents of the disk image. Double-click the installer icon to begin
the process. The installer will bring up a welcome screen. Click Continue to go to the next screen.

The installer will ask you to select the destination volume where Bandit will be installed. Typically you
will only have one hard disk and it will have a green arrow on it, indicating this is the selected drive. If
you have more than one drive and you want to store the software on one of the other drives, click on the
drive and the green arrow will move to this selected drive. Click Continue to go to the next screen, then
click Install.
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Next the installer will ask where you want to install the program. By default, the program installs the
software into a folder called Bandit in your Applications folder. You can install the program somewhere
else if you have limited space on your main drive.

The installer installs the software and you will see a screen indicating the installation was successful. Click
the Close button to exit the installer.

2.3.3. Upgrading from an Earlier Version of Bandit

If you are updating from an earlier version of Bandit already installed on your computer, the program
will automatically save a backup of your existing data file and reload the data from the backup once the
new version of the software has started to run. You will see a pop-up box informing you that the program
is going to reload the data from the previous version. If, for some reason, you do not wish to reload the
data from the previous version, you can click Cancel here. Usually, though, you will want to click OK to
reload the data from the previous version. After you click OK the reload will proceed and you will see a
box showing the summary of the reload process. Click OK to continue. Next, you may see a box showing
that the program is updating the values in the Wing and Weight tables. This patching process will only
change values if they are the same as they were when the original Wing and Weight table was installed.
(If you modified values in the Wing and Weight table, those values will not be changed.) Finally, a box
will appear asking if you want to delete the backup file which was created during the installation process.
Click OK to continue.

Warning

As mentioned above, the upgrade process automatically saves a backup of your existing data
file prior to installation. We recommend, however, that you create your own backup using
the regular backup facility within Bandit prior to performing the upgrade process. Store this
backup in a safe place, such as a removable drive, a floppy disk, or a CD.

2.4. Running Bandit
Once you have successfully installed Bandit onto your computer you can run the software by a variety of
methods. In Windows, select the program from the Bandit group in your Start menu, double-click the icon
for Bandit on your desktop (if you requested one during installation) or single-click the small bird icon in
your Quick Launch bar (if you requested one during installation). In Mac, open the Applications folder,
find and open the Bandit folder, and drag the bird picture icon for Bandit down to your dock. Then it will
always be available for easy execution with a single click of the mouse.

2.4.1. Bandit Opening Screen

When you first launch Bandit, you will see the Bandit opening screen, and a small dialog box will appear
asking if you want to save a backup of your current Bandit data file. It is a good idea to save a backup
whenever you are going to be making changes to the file, in case you need to return to an earlier version
of the database.



Installing Bandit

6

Figure 2.1. Bandit Opening Screen

After you have dispatched the Backup dialog box, you will be presented with an opening screen showing
three ways of entering the program on the left and a summary of the banding data contained in the Bandit
data files on the right. The three ways of entering the program are presented as a numbered list:

1. Edit Settings. Click here to go directly to the Settings screen. If this is the first time you are using
the Bandit program, it is very important that you go here first to set your basic settings for using the
program. Refer to Chapter 3, Bandit Settings for more details on the settings you can make to tailor
your experience with Bandit.

2. Add/Edit/View Band Inventory. Click here to go directly to the Band Inventory screen. If you just
received some new bands from the BBL or the BBO, you need to go here to add the bands to your
inventory via the Add To Inventory process. If you are importing data from Band Manager, refer to
Chapter 11, Importing and Exporting to successfully complete this process. Chapter 4, Band Inventory
has a description of the use of the inventory and how to add bands into your inventory.

3. Add/Edit/View Bands. Click here to go directly to the Bands screen. If you just returned from a banding
session, you probably want to go here to input the data you collected in the field into Bandit. Refer
to Chapter 5, Banding with Bandit for more information about entering banding information into the
program. Appendix A, Tips and Shortcuts contains useful keyboard shortcuts which will make the task
of entering your banding data even faster.

Tip

Unlike most other computer applications you have encountered, Bandit saves the information
you enter automatically whenever you go to another record or screen.
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2.4.2. Getting Around

Once past the opening screen, all of the screens in Bandit share a similar layout. For example, Figure 2.2,
“Bandit Screen Layout” shows the Bands Table View screen, with numbers added to identify the various
areas of the screen.

Figure 2.2. Bandit Screen Layout

The menubar appears at the top of the Bandit window (along the top of the screen on Macintosh OS
X) and has the usual features of every application, including the ability to Exit or Quit the application,
found in the File menu, and the Cut, Copy, and Paste functions in the Edit menu. The ability to import
and export data can be found in the File menu, and the Records menu has functions for working
with the records in the built-in database. There is no Save function in the File menu, because Bandit
automatically saves each record as you enter it.
The gray navigation panel along the left-hand side of the window allows you to change between
Browse mode, selected by clicking on the pencil icon, where you view and edit your data and Find
mode, selected by clicking on the magnifying glass icon, for searching and filtering the contents of
your data. You can leaf through your data as easily as flipping through the pages of a book, and see
at a glance how many records are in your file. At the bottom of the navigation panel are 4 boxes.
The left one, here containing the value 100, shows the current zoom level. Click on the second box
containing the smaller mountain range to zoom out the window for a big picture view. Click on the
third box containing the bigger mountain range to zoom in the window for a detailed view. Click on
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the fourth button with the panel icon to toggle hiding or showing the navigation panel. You can set
a custom zoom by clicking on the first box.
The five buttons near the top of the screen allow you to switch easily to one of the five sections of
the program: Inventory, Bands, Reference, Recaptures, and Settings.
The function panel below the section buttons changes depending on which section you are in.
If you want to get back to the opening screen, click on the line containing the word Bandit. The
opening screen summarizes the number of bands in your file and their status.

Take a minute or two to look through the menus and familiarize yourself with the layout of the Bandit
program. It will pay dividends in the future through increased efficiency and understanding all the features
Bandit has to offer.

2.5. Creating and Using the Bandit Backup File

2.5.1. Creating a Backup File
Each time you open Bandit you will see a pop-up box that asks you if you wish to create a backup file. It
is recommended that you always choose OK. By selecting OK, a backup file is created and saved before
you start making changes to the data with the program. The backup file is normally saved into your My
Documents folder (Documents folder on the Macintosh) but you have the option of choosing an alternate
location. Then, if something happens while you are in the program, you can use the backup file to restore
the Bandit data up to the date of the backup. By selecting OK at the beginning of each session, there is no
need to worry about being unable to recover from unanticipated problems. To identify the backup files,
Bandit gives them a special name which includes the date and time the backup was created. (Bandit Data
bak 200803141549.fp7 is the backup created March 14, 2008 at 3:49pm.) You may delete these files
anytime you wish, but you may want to keep at least the latest two or three files in case you need to use
them. You may also create a separate folder and move them there after they are created.

Tip

For additional protection against unforseen circumstances such as disk crashes, operating
system corruption, etc. it is a good idea to store your backup files on a separate disk than
the one containing your primary data file. You can store the files on a removable disk such
as a floppy disk, a CD, a USB-based drive, or a different hard drive in your system, if you
have more than one.

2.5.2. Restoring from a Backup File
If you inadvertently delete your data file or you feel you have corrupted your data file to the point you
must step back to a previous version, restoring from a backup file may be indicated. Keep in mind that if
you choose to restore from a backup file, all of the data in the current data file will be lost.

Restoring data from a backup file created in Bandit 1.02 or later is quite simple. From the File menu at the
top of the screen, click Restore From Backup. Navigate to your My Documents folder (Documents folder
on the Macintosh) and select the backup file that you wish to use to restore your data. A pop-up box will
appear showing you the results of the restore process.

Restoring data from a backup file created in Bandit 1.0 is a little more complicated. After you select the
backup file you wish to use to restore your data, a series of dialog boxes will appear asking you to put in
your Name and Password. In the name field, enter user for the name and leave the password field blank.
At the end of this process, the pop-up box will appear showing you the results of the restore process.
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Chapter 3. Bandit Settings
Note

if this is the first time you are using Bandit, it is imperative that you fill in the fields under
both the Bander Info and Locations tabs in the Settings section. All of the submission functions
and location data rely completely upon having the information completed correctly in the
Settings section.

You can navigate to the Settings section of Bandit by clicking on the button labelled 1 on the opening
screen or by clicking on the Settings section button at the top of any of the other screens.

Figure 3.1. Bandit Bander Info Settings Screen

Once you are inside the Settings section, you will see six tabs: Bander Info, Data Entry, Band Edits, Locations,
Wing & Weight, and User Fields. Each of these tabs has fields to be filled in. The most important tabs are
Bander Info, which allows you to enter information about the master bander and the sub-banders, and
Locations, which allows you to enter information about your banding locations.

To leave the Settings section, click on any other section button near the top of the screen. If you allow
your mouse to pause over each of these buttons you will see the purpose of each section. You can also
click on the word Bandit at the top of the screen to return to the opening screen, kind of like the home
page in a web site.
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3.1. Bander Info
Note

It is imperative that you fill in the bander information since it will be needed for the data
submission task to correctly identify your data when it is received by BBL or BBO.

Click the Bander Info tab to bring up the page where information about the banders can be stored. First, put
in the name of the Master Bander (or the station name followed by the name of the responsible individual
if you have a station permit) in the Master Bander field. Next, in the Permit Number field, enter the Permit
Number that was assigned to you or your team by the Bird Banding Lab or the Canadian Bird Banding
Office. Choose the country where data has to be submitted by clicking the appropriate radio button. If you
hold a U.S. permit, click in the U.S. radio button and if you hold a Canadian permit, click in the Canada

radio button. Next, begin filling in the table below these entries by first clicking on the Add button. Be sure
to enter the Master Permit holder’s name as well as any other banders as this table will be used during the
data entry step to fill in the initials of the banders who actually banded a particular bird. Begin by typing
in the Master Bander’s initials, the name of the Master Bander and entering the email address and phone
number in the appropriate fields (if desired). Only the initials (or other unique identifier) and name are
required. In the Sub ID field you may put in a sub-bander's Alpha id (as assigned by the BBL or BBO),
but leave this field blank for the master bander. None of the information in this table is transmitted to the
BBL or BBO. It is for your own convenience to maintain information about the banders.

If you inadvertently click the Add button after you have added the final bander and then try to leave the
screen, you will get an error message. Delete the blank line in the table by clicking on the Delete button.

If you wish to delete a bander, click with your cursor on the row containing the bander you wish to delete
and then click the Delete button on the right. This will delete the information contained in the entire row
of the table.

If you have more entries in the banders table than are visible in the space provided you can scroll through
the table using the scroll bar on the right.

Tip

If you have more banders than can be seen on the screen and you want to print out a list of
all of them, click on the Export button to the right of the table. An Export Records File dialog
box will appear. Choose where you wish to save the file and type the name of the file in
the appropriate box and choose the type of file you would like to save in the Save as Type
box. (Choose .tab for a tab-delimited table, for example.) Next, in the Specify Field Order for

Export dialog box, choose which fields you wish to export and in what order. Then, click the
Export button and a file will be created that you can print or email.

3.2. Data Entry
Clicking on the Data Entry tab will bring up a page with information about code formats, language, and
measuring units used by the program. If you pause the mouse over each field, a pop up window will appear
giving more details on what goes in that field.

In this section you have the option to select the code format for entering Species, Bird Age, and Bird
Sex codes. The code formats available are alpha and numeric. To select a code format just click in the
appropriate radio button. When a format is changed, the program will rebuild the related lookup table to
correspond to the selection you have chosen and then go through the Band and Recapture tables, changing
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the codes in all of the records to match. Measurement units for Weight and Length are grams and mm,
respectively, and cannot be changed.

Warning

If you are importing banding data, the code formats in the import file must match the code
formats set inside Bandit. Band Manager export files always use numeric coding, even if you
use the alpha option in the program.

Figure 3.2. Settings Screen—Data Entry Tab

3.3. Band Edits
Clicking on the Band Edits tab will bring up a page with a few settings controlling the way edits are
performed on the banding data. You have the ability to disable/enable Wing Chord, Weight and Time
Check. If the Wing Chord and Weight Check boxes are clicked, species for which there are data in the Wing
and Weight table are run through edits to help ensure you have correctly recorded these measurements
at banding. Any discrepancies encountered during the check will appear in the Additional Errors field. All
other edits are performed automatically and are not dependent on user preferences.
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3.4. Locations
An important characteristic of the banding and recapture data submitted to the BBL/BBO is the quality of
the banding location data attached to the record. In the past, due to limited computer memory and storage,
the BBL/BBO stored locations only with 10-minute block precision in both latitude and longitude. Because
of advances in computer hardware technologies, the precision of banding locations can be significantly
enhanced. In Bandit, we have taken the opportunity to permit the storage and submission of banding
locations to the nearest second. If you prefer, you can use 10-minute block precision or 1-minute block
precision.

All of the banding locations are stored in a table which can be easily accessed at any time by clicking on
the Locations tab within the Settings function. The table has places for a short identifier, or ID, for each
location (which must be unique), Location Description, fields for Latitude and Longitude coordinates (in
degrees, minutes, seconds, and hemisphere), and Country, State, and County fields. State and County are
placeholder names for the 1st and 2nd administrative divisions of the country. The last 2 columns, Valid?

and Bands Count, are used by the system to provide feedback on the locations in the table. Valid? will have
the value Yes if the location record has passed the edits and the coordinates provided match the bounding
box outline for the Country and State provided. If the value in Valid? is No, you can place your cursor over
the box containing the No to see what edits this location did not pass. (The errors will appear in a popup
box, called a tool tip.) Bands Count shows how many bands have been banded at a particular location.

Figure 3.3. Bandit Locations Settings Screen

Four buttons are placed to the right of the table to facilitate maintaining the locations table: Add, Delete,
Print, and Export.

Add To add a new location into the locations table, click the Add button. The cursor will
automatically be placed into the first column of the new entry.

Delete If a location has been entered in error or is not being used it can be deleted. First click anywhere
on the row containing the location to be deleted and then click the Delete button. The system
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checks to make sure that there are no bands with that location in the database. If there are none,
the location will be deleted. If there are bands at that location, you will get a message.

Print Use the convenient Print button to print out the locations.

Export If you are interested in using the location information in another program you can use the Export

button. The exported locations can be put into a file in a variety of formats. See Chapter 11,
Importing and Exporting for more details on the formats provided.

To begin entering locations in the Locations table, click on Add at the right of the table. The cursor will
automatically be placed into the first column of the new entry and a question mark will appear. Begin typing
up to 8 characters to create a unique location identifier. It may contain alphabetic and numeric characters.
Press the Tab key to move to the Loc Precision field. There are three options available here: the traditional
10-minute block, a more precise 1-minute block, and the capability to enter an exact location.. Each option
will have different effects on the Degrees, Minutes, and Seconds entries under Latitude and Longitude.

Tip

Choose 10-minute block precision if you have multiple banding sites in the same 10-minute
block and do not wish to catalog all of the locations separately or you wish to be less specific
about the location of a sensitive species.

Using 1-minute block precision is recommended for an operation like a MAPS station or
migration monitoring station, where several mist nets are in a small area. There is no need
to identify each net site as an exact location.

Choose Exact Precision if you are only banding at one location or several well-separated
locations. Some banders at MAPS mor migration monitoring stations may choose to use a
centroid for the net locations and use this option, instead of the 1-minute block option.

See the sections below for more information on how to enter locations for each option.

3.4.1. Entering Locations with 10-Minute Block Precision
If you choose 10-minute block, a 10 will be entered in the Loc Precision column and 00 will automatically
be entered into the Sec column for both latitude and longitude. Next, enter a location description. The
description must be identifiable on most common maps and should include miles and direction from an
identifiable landmark such as a town, lake, highway, etc.

Note

It is important to describe the location in such a way that it can be relocated by others,
because this information will be used for the Certificate of Appreciation provided to a person
who may report this bird in the future. A good location description could help them locate
(approximately) where the bird was banded using a common map. More importantly, at the
BBL, we use the description you provide to confirm the coordinates. Do not put country,
state, province, or county into the location description field. There are separate fields for this
information.

After entering the description, enter the degrees and minutes of latitude that correspond to the banding
location using the closest 10-minute line of latitude to the south. The number of minutes entered can only
be 0 through 5. You may then press the Tab key and a 5 will automatically be inserted as the second
digit. If you enter a second digit in the Minute field, the program will automatically change it to a 5. This
is because if you selected 10-minute block as the location precision, the program is expecting the value
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entered to be the center of the 10-minute block. After the latitude, enter the number of degrees and minutes
of Longitude to the closest 10-minute line of longitude to the east. The number of minutes entered again
can only be 0 through 5 and after pressing the Tab key, the second digit will automatically default to 5
for the same reason as described in the latitude entry.

Tip

South of the equator, the closest 10-minute line of latitude to the north of the banding location
should be chosen. Likewise, when banding east of Greenwich, choose the closest 10-minute
line of longitude to the west of the banding location.

If you selected U.S. for where you want your data to be submitted during the Bander Info settings set up,
United States will be the default in the Country field. If you are entering data for a non-U.S. location,
you may change this by selecting the correct country from the drop down list. Typing the first few letters
of the country will shorten the list closer to the correct country. Press the Tab key again to go to the State/

Prov field and select the appropriate state or province. If your country is United States, the drop down list
will be populated with the U.S. states and again, the list can be shortened by typing the first few letters of
the state. If you selected data submission to Canada during the Bander Info settings set up, Canada will be
the default country and the drop down list for State/Prov will be populated with the Canadian Provinces.

For U.S. locations, a county for the banding location will be required. After selecting United States as
the country and selecting the appropriate state, the county list for that state will appear in the drop down
list. Select the appropriate county from the list provided and again, typing the first few letters of the county
will shorten the list.

If all of the information is correct, a Yes will appear under the Valid? column. If a No appears, place your
cursor over the No to see why the location is invalid. It may be for one of several reasons: the latitude and
longitude are not in the state or country entered, the second digit of the minutes field is not a 5, or the two
digits of the seconds field are not zeros. If it is a U.S. location, the county must be entered. Check these
fields and ensure they are correct.

3.4.2. Entering Locations with 1-Minute Block Precision
If you choose 1-minute block, a 1 will be entered in the Loc Precision column and 30 will automatically
be entered into the Sec column for both latitude and longitude. Next, enter a location description. The
description must be identifiable on most common maps and should include miles and direction from an
identifiable landmark such as a town, lake, highway, etc.

Note

It is important to describe the location in such a way that it can be relocated by others,
because this information will be used for the Certificate of Appreciation provided to a person
who may report this bird in the future. A good location description could help them locate
(approximately) where the bird was banded using a common map. More importantly, at the
BBL, we use the description you provide to confirm the coordinates. Do not put country,
state, province, or county into the location description field. There are separate fields for this
information.

After entering the description, enter the degrees and minutes of latitude that correspond to the banding
location using the closest 1-minute line of latitude to the south. The number of minutes entered should be
00 through 59. You may then press the Tab key 3 times to tab to the Longitude degrees field. Next, repeat
the process for the longitude degrees. Enter the degrees of longitude and press the Tab key to get to the
Minute field. Then enter the closest 1-minute line of longitude to the east. the number of minutes entered
again should be 00 through 59. Then press the Tab key 4 times to enter the State/Prov field.
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Tip

South of the equator, the closest 1-minute line of latitude to the north of the banding location
should be chosen. Likewise, when banding east of Greenwich, choose the closest 1-minute
line of longitude to the west of the banding location.

If you selected U.S. for where you want your data to be submitted during the Bander Info settings set up,
United States will will be the default in the Country field. If you are entering data for a non-U.S. location,
you may change this by selecting the correct country from the drop down list. Typing the first few letters
of the country will shorten the list closer to the correct country. Press the Tab key again to go to the State/

Prov field and select the appropriate state or province. If your country is United States, the drop down list
will be populated with the U.S. states and again, the list can be shortened by typing the first few letters of
the state. If you selected data submission to Canada during the Bander Info settings set up, Canada will be
the default country and the drop down list for State/Prov will be populated with the Canadian Provinces.

For U.S. locations, a county for the banding location will be required. After selecting United States as
the country and selecting the appropriate state, the county list for that state will appear in the drop down
list. Select the appropriate county from the list provided and again, typing the first few letters of the county
will shorten the list.

If all of the information is correct, a Yes will appear under the Valid? column. If a No appears, place your
cursor over the No to see why the location is invalid. It may be for one of several reasons: the latitude and
longitude are not in the state or country entered, the minutes field is not in the range 00 through 59, or
the two digits of the seconds field are not 30. If it is a U.S. location, the county must be entered. Check
these fields and ensure they are correct.

3.4.3. Entering Locations with Exact Precision
If you choose Exact from the Loc Precision drop down menu, a 0 will be entered in the Loc Precision
column and you will be required to fill in the exact degrees, minutes, and seconds in both the latitude
and longitude columns. Next, enter a location description. The description must be identifiable on most
common maps and should include miles and direction from an identifiable landmark such as a town, lake,
highway, etc.

Note

It is important to describe the location in such a way that it can be relocated by others,
because this information will be used for the Certificate of Appreciation provided to a person
who may report this bird in the future. A good location description could help them locate
(approximately) where the bird was banded using a common map. More importantly, at the
BBL, we use the description you provide to confirm the coordinates. Do not put country,
state, province, or county into the location description field. There are separate fields for this
information.

After entering the description, enter the degrees, minutes, and seconds of latitude that correspond to the
banding location. The degrees entered should be in the range (longitude: 0-180, latitude 0-90). Minutes
should be in the range 0-59, Seconds should be in the range 0-59.

3.5. Wing & Weight
Clicking on the Wing & Weight tab brings up a table showing minimum and maximum wing chord and
bird weight by sex for each species for which data was available in the Identification Guide to North
American Birds, Part 1 by Peter Pyle. This table is used to validate the wing chord and weight information
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collected via the optional wing and weight edits. (See Section 3.3, “Band Edits”.) Measurements that fail
this edit will appear in the field Additional Errors. This edit is intended to help catch data entry errors.
The values in the table are incomplete, but we have provided the capability of editing them. If you wish,
you can add values for species we did not include or change the values for species if they differ in your
geographic area. Use the Find feature to find one or more species of interest by typing in a name, Alpha
Code, or numeric Species Code and clicking the Find button. You can type a partial value and the entries
that match will be returned. Click the Show All button to see all of the species. Finally, you can click the
Export button to export the wing and weight values. See Chapter 11, Importing and Exporting for detailed
instructions on the use of this feature and the file formats supported.

3.6. User-defined Fields
Click on the User Fields tab to enter the labels for up to 5 additional fields you want to associate with
your banding/recapture record. For example, change one of the labels to Field Notes to create a place to
enter your field notes associated with a banding. Each of the 5 fields can contain an arbitrary amount of
information. Chapter 5, Banding with Bandit contains additional details on the use of this feature.

Figure 3.4. Bandit User-defined Fields Settings Screen

3.7. Other Settings
There is one additional setting to turn on or off the automatic spell checker in Bandit. Find this option
by selecting File Options from the File menu. The spell checker is most useful in finding spelling errors in
remarks fields, which will show up with a special colored underline familiar to users of Microsoft Word.
For this application, though, many users will find the spelling checker unnecessary and intrusive.
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Chapter 4. Band Inventory
The Band Inventory in Bandit contains information about the strings of bands you have received from the
Bird Banding Lab. These bands are issued in strings having contiguous numbers spanning a range. This
string of bands is commonly referred to as a band span.

You can navigate to the Band Inventory section of Bandit in one of two ways: Click on the button labeled
2 on the opening screen, or click the Inventory button at the top of any of the other screens.

Figure 4.1. Bandit Band Inventory Screen

The primary function of the Band Inventory screen is to allow you to add bands to your inventory and
edit the information about the band spans in your inventory. On the rare occasion that a span needs to
be removed from the inventory, there is a facility provided for removing the span (and its associated
banding records) from the inventory. Additionally there is a function for removing unused bands from
the inventory and an option for importing band spans into Bandit. For more details on importing, see
Chapter 11, Importing and Exporting.

To add band spans to your inventory, go to the Inventory page and click on the Add to Inventory button
in the functions bar above the table. This will bring up a new window with fields for entering the band
number prefix, the starting and ending numbers of the suffix, the band size and type, the date you received
the bands from the Lab, and a place for remarks.
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Figure 4.2. Add to Inventory Screen

First, enter the date you received the bands from the BBL/BBO or from another bander who transferred
the bands to you. You can do this in one of two ways. You can click on the calendar icon at the far right
of the Date Received field and scroll to the correct month and year you received the bands and then just
click on the date. You may also just click in the date field and type the date. If you do this, be sure to use
the format mm/dd/yyyy. After entering the date, the program will advance to the Prefix field. Enter the 4-
digit prefix of the band string you received and press the Tab key. Next, enter the 5-digit suffix of the first
band in your span and press the Tab key. Then, in the next field, enter the 5-digit suffix of the last band
in your span. Enter the prefix and the two suffix values carefully. You will not be able to make changes to
these fields later without deleting the span. The other fields can be modified later, if necessary.

Note

A complete string of bands have suffix numbers starting at 00001 and ending with 00000.
(00000 really means 100,000 here; the 1 is “silent”.) So if you have a span containing a suffix
with all zeros, it is always the ending suffix.

Press the Tab key to enter the Band Size field. Next, enter the Band Size. You can do this by selecting it
from the drop down menu or typing it in directly. If the number entered in this box does not correspond
to the last digit in the prefix, a pop up box will appear to warn you. The program will move you forward
to the Band Type field, from which you may select the appropriate band type from a drop down menu.
You can press the Tab key and enter a remark for that particular band span, if necessary. Finally, click the
Submit button at the bottom of the window to initiate the add to inventory process. Bandit will create a
banding record for each of the bands within the span and automatically link them to the band span.

Note

Depending on how many bands are in the band span, the process of adding the bands to your
inventory can take a while to finish.

If you entered a band span erroneously, are transferring bands to another bander, or returning bands to your
coordinator at the end of a banding season, you may want to remove those bands from your inventory. To
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remove bands from inventory you have two options: remove the whole span or remove unused bands from
the span. To remove a whole span, select the span you want to remove by clicking with your cursor inside
the line of the desired span on the Inventory page. Then click on the Records menu at the top of the page
and select the Delete Inventory Record item from the menu. A message will appear to confirm you really
want to remove the whole span, pointing out how many of the bands in the span are used, if any. You may
cancel at this point, or proceed, in which case all related banding data will be removed from the band table
and saved in a .xls file in your My Documents folder (Documents folder on the Mac). For example, if you
removed the bands 1234-00001 through 1234-00024 on January 12, 2007, the name of the saved file is
Unused_Bands_123400001_123400024_20070112.xls.

To remove unused bands from a span, select the span you want to modify by clicking with your cursor
inside the line of the desired span. Then click on the Records menu at the top of the page and select the
Remove Unused Bands item from the menu. A message will appear stating how many unused bands will
be removed. You may cancel or proceed. If you proceed, the band span inventory record will be split, to
leave in inventory only the used bands. The Unused Bands Removed Report will appear on your screen.
You may print the report (using the tool bar icon) and then click Continue on the left panel of the window
to resume using the program.

To leave the Band Inventory section, click on one of the other Section buttons near the top of the screen.
If you allow your mouse to pause over each of these buttons you will see the purpose of each section.
You can also click on the name Bandit at the top of the screen to return to the opening screen, kind of
like the home page in a web site. Typically, after entering spans into the band inventory you are ready
to enter banding information. If so, just click the Bands section button near the top of the screen to go to
the screen with the bands.

Note

If you imported bands from Band Manager, the date received will be the date you performed
the inventory process. If there are data associated with these bands that will also be imported,
you must change the date received to be a date earlier than the first bird banded using
these bands. To do this, go to the inventory page, click on the date in the line containing
the imported bands and simply retype a date that is earlier than any banding date for birds
associated with these bands. Everything else can remain the same.

Tip

You can sort the records in your inventory by using the Sort Records... item in the Records

menu. You can also use Find mode to select the spans you want to work with. For more
information about Find mode, see Chapter 8, Find Mode.
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Chapter 5. Banding with Bandit
Clicking on Step 3 from the opening screen or clicking on the Bands section button from one of the other
screens will bring up the banding screen. This is actually a pair of screens showing two views (or modes)
of the same information. The Table view shows a spreadsheet-like table of the information in the banding
records. You can use this view to see a number of banding records at a glance and rapidly enter a large
amount of data, but only a limited number of fields are visible without using the scroll bar at the bottom of
the window. The Details view allows you to see most of the fields in a particular banding record at once,
but only for one record at a time. This view can be easily navigated by using the light gray navigation panel
which appears to the left of the screen. Using this panel you can flip forwards and backwards through the
banding records or jump directly to a particular banding record.

Figure 5.1. Bandit Bands Table View Screen

By default, you always enter the Bands screen in Table view. To switch to Details view, click the Details

function. This function name will switch to Table once you enter Details view. To switch back to Table
view, click the Table function (which will be in the same location as Details was prior to selecting the
Details function.)

Note

Looking for the Save item in the File menu? Bandit automatically saves data whenever you
leave a record or go to another screen so you never have to worry about doing the save
yourself.
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5.1. Bands Screen—Table View
The table mode presents the banding data in much the same way as it would appear in a spreadsheet. Like
a spreadsheet you can rapidly enter information and use other keyboard commands to skip to the next and
previous fields, duplicate information in successive records, jump to the first field in the table, etc.

5.1.1. Resizing and Repositioning Columns
In the Table view, Bandit allows you to set the relative position and width of each column. Once you set
the widths and positions, the columns will remain the way you set them through each successive use of
the program, until you change them again. To set the width of a column, position the cursor between two
column headings. A double-headed arrow cursor will appear. Click and drag the cursor to the left to make
the column smaller and right to make the column larger. To reposition a column, click and drag the column
heading to a new location to the right or left. A dark line will appear to show you the position you are
dragging to as you drag the column to the left or right. When you get the column where you want it, let
go of the mouse button. The column will move in place.

Tip

There are 12 fields that are transmitted to the BBL/BBO when you submit data. These fields
are Band Number, Disposition, Species, Age, How Aged, Sex, How Sexed, Banding Date, Bird

Status, Location, Aux Marker Combined, and Remarks. All of the data in these fields must be
error free in order for the data to be submitted. It is therefore recommended that you locate
the Error Text column, click on the heading, and drag that column so it is immediately to the
right of these columns. Any errors in the mandatory data will then be readily visible and can
be corrected immediately.

5.1.2. Sorting Columns
Most of the time when you are entering data you will want to see the banding records sorted in band number
order. For other uses, you can sort on any column by just clicking on the column header. Click once to sort
in ascending order. Click again to sort in descending order. Click on another column to sort the records
based on the value in that column. You can always sort records by using the Sort Records function found
in the Records menu at the top of the screen. It can sort by multiple columns.

5.1.3. Entering Banding Data in Table View
To enter banding data, click on one of the columns to start. You can see what is supposed to be entered
into a particular column by pausing with your cursor over each column. A small text box will appear with
details on what is supposed to be entered into each field. You cannot enter anything into the band number
field as that field is pre-populated from the add bands to inventory process. Pausing over the band number
field will give you a summary of information about the band.

Many of the fields have a list of possible values associated with them. You can click the little triangle to
bring up the list or just type in the value yourself. For coded fields, you may wish to refer to the associated
reference table. You may do so at any time by clicking on the Reference section button near the top of
the screen. When you return to the Bands section, you will still be in the same place you were when you
left the screen.

The Species, Age, and Sex fields can be coded using either alpha or numeric codes. Refer to the Data Entry
section in Chapter 3, Bandit Settings, for details on how to tell Bandit which coding format you wish to
use (and be sure the Settings section is completed prior to entering band information.)
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Many of the fields feature type-ahead completion. As you type, the program looks through the list of
possible values and finds the first one that matches what you have typed so far, completing the value. If this
is the value you want you can just Tab to the next field. If this is not the value you want, continue typing
until the value is matched. The Tab key takes you to the next field. Shift-Tab takes you to the previous field.

Most of the fields are self-explanatory, but a few things need extra attention to prevent errors. Most
important is the banding date. The banding date must be after the date you received your bands. In most
cases where you imported bands from Band Manager, the date received will be automatically defaulted
to the date you completed the import process. If that date isn’t changed as described in the importing data
and add to inventory process in Chapter 4, Band Inventory, you will get an “Invalid Banding Date” error.

Tip

Using the Filter function before entering banding data helps to focus on those bands you
will be using during a session. Select the prefix and the starting and ending suffixes and
click the Filter button. Only those records will appear in the table. Click the Show All button
to see all of your bands in the table. See Section 5.6.1, “Filtering Banding Data” for more
information about filtering banding data, and see Chapter 8, Find Mode for information about
an alternative way to select banding records you want to operate on.

5.2. Bands Screen—Details View
The Details view of the Bands screen presents the banding data as a collection of fields shown as a form,
making it easier to group related information (such as auxiliary marking). Although the screen presents
data on only one band at a time, a navigation panel is provided to scroll through the banding records. The
Details view also provides additional features not available in Table view for double banding, auxiliary
marking, error reporting and bypassing certain errors, reporting recaptures, and more.
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Figure 5.2. Bandit Band Details View Screen

Entering banding data in Details view has all of the features from Table view, described in the previous
section, including help when you pause over a field, value lists, type-ahead completion, and the use of the
Tab key (and Shift-Tab) to jump from one field to the next.

5.2.1. Using the Navigation Panel

The Details view provides a navigation panel on the left-hand side of the screen. The navigation panel
uses a book-of-banding-records metaphor. In the middle of the panel is an open book. Click on the left-
hand page of the book to go to the previous banding record. Click on the right-hand page to go to the next
banding record. Use the slider below the book to rapidly scroll ahead or back in the book of records.

5.2.2. Entering Auxiliary Marker Data

The Details view has a handy tab named Aux Marker which is ideal for entering auxiliary marker data
associated with a bird. First choose a marker type from the drop-down list in the Aux Marker Type field.
If the auxiliary marker contains a code, click on the circle with Y in the Is Aux Marker Coded? field and
fill out the left-hand side of the screen, indicating the code value, the color of the band, and the color of
the code. If the bird is marked by a sequence of uncoded colored bands on one or both legs, click on the
circle with N in the Is Aux Marker Coded? field and fill out the right-hand side of the screen, choosing the
colors for the sequence of bands as appropriate. The Remarks field is repeated here, making it easy to add
explanatory remarks.
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Figure 5.3. Aux Marker tab on the Bands Screen—Details View
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Figure 5.4. Aux Marker for a Sequence of Uncoded Colored Bands

The Aux Marker Combined field is automatically generated from the rest of the information on the screen. It
summarizes the information entered into a single field suitable for submission. This is the auxiliary marker
field that is submitted to BBL/BBO.

Note

The Aux Marker facility in Bandit is a work in progress, and currently only accomodates
relatively simple auxiliary marking conditions. If you find that the marking you are doing
cannot be described fully here, contact the BBL or BBO for advice. For example, if you used
more than one type of marker, one of which is coded, we may advise you to describe only
the coded one, and mention the others in remarks. In this case, you would set the Aux Marker

Type field to match the type of the coded marker.

5.2.3. Entering Data for Double Banded Birds
If your banding permit authorization allows it, the Details view makes it easy to add data for double banding
birds. First, make sure the Disposition code associated with the band is D. Fill in the remaining data fields
and then, in the field Second Band Number, type the band number for the other band. Then click the button
next to the field labelled Fill Second Record. Bandit will copy the data from the current banding record into
the record for the second band number, changing the Disposition code to S and setting the Second Band

Number field to the starting band number.

5.2.4. Recording Recaptures
If you want to record the recapture of a bird you banded previously, click the button next to the band
number labelled Report Recapture. A new recapture record will be created and you will automatically be
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switched to the Recapture function. This feature will only work if you banded the bird and have the banding
record in Bandit. See Chapter 6, Recaptures for complete details on recording recaptures.

5.3. Error Checking
Bandit automatically and transparently checks the banding data using a variety of editing checks to ensure
the data are coded correctly and the fields are internally consistent. You can see the errors Bandit has
identified by looking at the Error field in the Details view or the Error Text column in the Table view. Where
possible, fields with erroneous or inconsistent data are highlighted in yellow. Also, the field containing
the error text will be highlighted in yellow if there are non-bypassable errors in the record. Refer to
Appendix C, Data Editing Error Messages for a complete description of the errors that may occur and how
to correct them. Some less-critical errors may be bypassed, allowing the banding record to be submitted
during the data submission process. Other errors may be bypassed after appropriate remarks are entered.
For example, the Bad Size error can be bypassed if an explanatory remark is added to the Remarks

field indicating why a different size band was used. When you click Y in the Bypass Error field, the error
message will still be visible, but the record will be submitted during the data submission process. If you
try to bypass errors and Bandit does not allow it, one or more errors in the record cannot be bypassed.
Records with errors that cannot be bypassed and records that have errors that can be bypassed but Bypass

Error was not set to Y will not be sent during the data submission process.

Errors that show up in the Error field (Details view) or Error Text field (Table view) must either be corrected
or bypassed for the data to be submitted. Errors that show up in the Additional Errors field of the Table or
Details view are informational only and are associated with fields that are not submitted. Errors in wing
chord, weight, and time appear here. These Additional Errors do not need to be bypassed in order to have
the record submitted.

5.4. Using the Remarks Field
Associated with each banding record is a Remarks field which is useful in several situations. Add an
explanatory remark whenever you bypass an error, indicating why the error does not apply to this record.
Add a remark as necessary for special auxiliary marking situations not covered by the capabilities of the
auxiliary marker fields. You can add any other information you want the banding office to be aware of.
Keep in mind that only the first 100 characters of the Remarks field are submitted to the BBL/BBO. If you
wish to keep other detailed information associated with a particular banding that is not sent to the BBL/
BBO, use one of the user-defined fields.

Note

The Band Manager program had a remarks field that applied to all 100 records in a band span.
In Bandit, each banding record has its own remarks. If the remark should apply to several
bands, use the ditto feature (see Appendix A, Tips and Shortcuts) to duplicate the remark
from the previous record.

5.5. User-defined Fields
Up to 5 additional fields can be associated with each banding record. You can create labels for these fields
on the Settings screen. Enter and edit information for these fields using the User Fields tab on the Details

view of the Bands screen or by referring to the User Field 1, …User Field 5 columns on the Table view. An
arbitrary amount of information can be stored in each of these fields. Use the scroll bar to scroll through
the information.
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Figure 5.5. User Fields tab on the Bands Screen—Details View

5.6. Other Features of the Bands Screens
The bands screens have several other important features. The most important is the ability to submit
banding data to the BBL or the BBO. Other features facilitate data entry and editing such as the ability
to filter the bands visible on the screen, propagate field values throughout a collection of bands, duplicate
the contents of a banding record, and clear out (reset) a banding record. Also, see Appendix A, Tips and
Shortcuts for additional enhancements to data entry and editing.

5.6.1. Filtering Banding Data
You may select which bands are visible in the Table view by filtering by prefix, suffix range, used and
submitted bands. If you fill in just the prefix, only those bands with that prefix will be on your screen. If
you fill in only the first suffix, all the bands in the span starting with that suffix will be in view. If you fill
in both suffix blocks, only those bands in that range will be in view. The Used and Submitted checkboxes
can be checked to narrow the list even further. The Used and Submitted boxes can be checked and used
without entering anything in either the prefix or suffix boxes as well. After you have entered your criteria
click the Filter button. To go back and see all of your bands click the Show All button.

Tip

If you open Bandit and all of your bands are not visible as you may expect, you may have
performed a filter operation the last time you used the program. In this case, be sure to click
on the Show All button to bring all of your bands back into view.

Tip

See Chapter 8, Find Mode for an alternative way to select banding records you want to operate
on. Find mode will permit you to do more complex searches and base your selection on any
of the fields in either the Table or Detail view.
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5.6.2. Fill-down Feature

The fill-down feature lets you quickly enter large amounts of banding data, in much the same was as the
Batch function in Band Manager. When using the fill-down feature all of the records in the set selected
will be updated with the criteria you selected to be filled down. It is important that you perform a filter
or find first so only the records you want will be updated.

Begin by filling in the prefix and suffix range for bands that have identical information for the fields you
wish to fill, and click Filter. Verify that these bands are the only ones now visible on your screen. Next, fill
in all of the blocks on the first line of the table. Go to the bottom of the screen and check each box to the
right of Fill Down By, selecting which information you want to have filled in the remaining records on your
screen. Then click Fill Down. A Verify Fill Down Operation box will appear, giving you the opportunity
to confirm this is actually what you want to do. Click OK if it is correct or Cancel if you see something
you do not intend to do. After clicking OK, all of the information in the selected columns will be repeated
in the remaining records.

Caution

It is imperative that you have the band numbers correctly selected/filtered before the fill-
down feature is used. This feature can modify large numbers of records at one time and the
operation cannot be undone.

After completing the Fill Down function, either select the next range of bands you wish to perform this
operation on or click Show All to return to the Table view showing all of your records.

5.6.3. Duplicating Banding Records

You can duplicate one banding record at a time using the Duplicate Band function located under the Records

menu found at the top of the screen. First, click with your cursor in any field in a row of completed data.

Move to the top of the screen and select Records → Duplicate Band and all fields of the current row will
be copied to the next row. CTRL-d is the shortcut for this function. To use the shortcut, click your cursor
in the row containing the data to be duplicated and press the CTRL-d key combination. The next row will
be populated with the same data.
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Figure 5.6. Bands Screen Records Menu

5.6.4. Clearing Banding Data
You can clear banding data using the Clear Band Record function located under the Records menu at the
top of the screen. Click in any field in a banding record to select that record and move to the top of the

screen on the menu bar and select Records → Clear Band Record. All of the data will be removed from that
banding record, returning it to the unused state.

5.6.5. Submitting Banding Data
The facility to submit banding data to the BBL and the BBO is initiated by picking the Submit Data function
found on the Bands screen. Chapter 7, Data Submission, has detailed information about this capability.
Before submission you may preview what data is going to be submitted by using the report "Banding Data
to be Submitted".

Tip

If you wish to have a printed or electronic record of the data you are submitting, make sure
you select the “Banding Data to be Submitted” report (or the “By Location: Banding Data
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to be Submitted” report) prior to submitting the data. This is the only means you have to
create a schedule similar to the one you had using Band Manager. Look near the top of the
screen and locate Report Name. Select Banding data to be Submitted or By Location:
Banding Data to be Submitted from the drop down list and click Show/Print Report. You
will get a Print Options box where you may choose to print, save, or export the report. This
will be your only chance to print a schedule. After the data are submitted they will no longer
show in this report.

5.6.6. Importing Banding Data

Banding data can be imported by selecting the File → Import → Bands item from the File menu. See
Chapter 11, Importing and Exporting, for more details on this capability.

Tip

Data quality checking constraints inside Bandit suggest the use of an ordered import
sequence. Bands must be added into your inventory before banding data can be imported.
Likewise, banding location data must be imported or created before banding data is imported
to avoid location errors. Finally, bander information must be available before banding data is
imported to avoid bander identification errors. Importing in this order: inventory, locations,
bander information, and importing bands last will ensure that data is consistent.

5.6.7. Exporting Banding Data
If you want to export your banding data for use in another program or to share it with other people you
can use one of several methods for data export found on the banding screen:

• Export Bands. Extract the banding information and create an external file in a variety of formats. You
can choose which fields you want to export and the order in which you want them to appear.

• Save as PDF. Saves a version of the banding record (or records) as it (they) appear on the screen as an
Adobe Portable Document Format (PDF) file suitable for printing or e-mailing.

• Save as Excel. This function outputs directly to the Microsoft Excel worksheet format. You cannot
choose which fields you want to see or the order in which you want them to appear. The entire Table
view will be exported into an Excel spreadsheet. If you want more versatility in the selection of fields
or order of the fields you are exporting, see Chapter 11, Importing and Exporting.

5.6.8. Reports
The Banding screen provides easy access to a variety of reports. Select the report you want to see from
the drop-down list and click the Show/Print Report button. The report will be created in another window.
You can flip through the pages by using the book icon in the navigation panel along the left side of the
window and then choose to send the output to the printer, save the results in Microsoft Excel format, or
create an Adobe Portable Document Format (PDF) file. See Chapter 9, Reports, for more details on the
reports provided and detailed instructions for using the report facilities.
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Chapter 6. Recaptures
A recapture is the capture of a previously banded bird. A resighting is the observation of a bird previously
marked with a unique identifier such as a neck collar, wing tag, or radio transmitter. Recaptures and
resightings are usually made by the original bander, but may be made by other banders, collaborators or
the public. Recaptures and resightings constitute the majority of post-release data obtained from banded
non-game birds, and for most analytical purposes the two can be considered equivalent. Individual banders
often make extensive use of their own recapture and resighting data.

A powerful suite of analytical models and software is available for analyzing recapture data to estimate
parameters such as survival, population size, rate of population change, movement probabilities, and age-
specific breeding probabilities. Many banders deliberately collect and analyze recapture data for their
project-specific needs. Others cumulatively collect millions of recapture data records suitable for use in
mark-recapture models but do not use them. The potential use of these data in population research and
management is great.

The functions available in the Recaptures section are similar to those in the Banding section. You have the
ability to add recaptures, delete recaptures, duplicate recapture records, clear recapture records, and submit
recapture data. The two viewing modes, Table and Detail, are also available. If this is a recapture of one of
your bands currently being maintained in the banding inventory in Bandit, choose R (for Recapture) from
the Disposition drop-down list. If you have recaptured a bird that was banded by someone else, choose F
(for Foreign Recapture) from the Disposition drop-down list.
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Chapter 7. Data Submission
In previous programs used to manage banding information, banding data were arranged to match a special
paper coding form called a Banding Schedule. Typically banders would populate the paper schedule, then
input the data into the program and create a file version of the schedule which was then submitted to the
BBL/BBO. Many banders found this confusing, as they were unsure whether they had to wait until the
schedule was completely filled out before they could send in the banding data.

In Bandit we decided to take a different approach. Whenever you have either new banding data or you have
modified some existing banding records you can submit the data. Hopefully this will make submission of
banding data less cumbersome and more timely.

Note

It is imperative that your data be nearly error free prior to using the data submission process.
As described in the data editing section, some errors may be bypassed and some may not.
Errors that cannot be bypassed must be corrected. Bypass Errors must be set to Y to skip these
errors. The program will tell you which errors can be bypassed when you attempt to bypass
them. Records that contain errors that cannot be bypassed, or errors that can be bypassed and
have not been, will not be transmitted using the data submission process.

Eight fields are required to be submitted. These include Band Number, Disposition, Species,
Age, Sex, Banding Date, Bird Status, and Location. If you have placed an auxiliary marker on
the bird and used a status code reflecting that, aux marker data fields are also required. If you
do not have these fields filled in or bypassed correctly, the aux marker data fields will not
be included in the submission record when you submit data. The How Aged and How Sexed

fields are not required, but if the fields contain data, they must be valid and consistent with
the rest of the data in the record. The Remarks field may also be required, depending on the
value of Bird Status, auxiliary marker, and whether errors have been bypassed.

7.1. The Data Submission Process
When you initiate the data submission process by clicking on the Submit Data function on the Banding
screen the system automatically goes through the data looking for bands that have been used but the data
has not been sent previously. These bands are added to a file for inclusion. The system also looks to see if
any banding record has been modified since the last time that record was submitted. If so, these bands are
also marked for inclusion in the data submission. Remember that only records without errors, or records
where the errors were bypassed (true only for bypassable errors) will be submitted.

Tip

If you wish to have a printed copy of the data for your records you are submitting in a format
similar to the schedule produced by Band Manager, you must select the Banding Data to be
Submitted report from the Report Name drop-down menu, then click Show/Print Report and
choose any options you want from the pop up box, prior to submitting data. This report can
only be created prior to submitting records.

You may also use the Banding Data to be Submitted report to see all of the records ready to
be sent. Any records containing errors will be highlighted so you can easily tell at a glance
which records need to be corrected. Go to the bands Details screen, where you can see all
the errors, and bypass them in appropriate cases or fix the errors. See Figure 7.1, “Banding
Data to be Submitted Report” for an example.
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Figure 7.1. Banding Data to be Submitted Report

Bandit prepares the file and displays a dialog box showing the number of records being submitted.
(See Figure 7.2, “Bandit Data Submission Dialog Box”.) After the dialog box is dismissed, Bandit will
automatically launch your system-wide email program to send the message containing the file directly to
the BBL or the BBO, provided the system is configured to do so.

Figure 7.2. Bandit Data Submission Dialog Box
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Figure 7.3. Bandit Data Submission Email

If your email program isn’t automatically launched, the file containing the data submission
is saved to your My Documents folder (Documents folder on the Mac) with the name
Bandit_Submission_PPPPP_YYYYMMDDHHMM.tab, where PPPPP is the permit number, YYYY is the current
year, MM is the current month, DD is the current day of the month, HHMM is the time the file was created.
So Bandit_Submission_55555_200607241020.tab contains a data submission that was created July 24,
2006 at 10:20am by the bander with permit number 55555. Open your email client as if you were sending
any normal email and type Bandit@usgs.gov (or Louise.Laurin@ec.gc.ca for Canadian Banding Office
submissions) in the address field and Bandit Banding Data Submission from PPPPP (Your Name) into
the subject field. Attach the file located in your My Documents folder as described above and then send
as any normal email.

The user has the option to create a Note for File, which will include a summary of all band spans and
locations submitted. You may print this note or save it as a file and attach the file to your submission e-
mail (this is not done automatically). The last Note for File will be available in the Report Name drop-down
menu, but only if you create the Note for File.
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Figure 7.4. Note For Submission File Report

Once a banding record has been submitted, a submission timestamp will be created by the program and
placed in the Submission Timestamp field in the Table view or the Submission Date field in the Details
view. A modification date is also maintained by the system, and changes whenever changes are made to
the banding record. If the banding record has been modified after its original submission, the record will
automatically be included in the next submission file. The Number of Submissions field on the Details view
indicates how many times a particular banding record has been submitted.

Tip

If you are importing data from Band Manager or some other source file and you are certain
that data has been previously submitted, you can use the Mark as Submitted feature (in the
Records menu) to create the submission timestamp. First, use the Filter feature or the Find

mode to select the subset of your records that have already been submitted. Next, choose
the Mark as Submitted item from the Records menu. The submission timestamp is created
for all of the records in the current found set and the records will not be included in future
submissions unless you modify a record. This can be handy if you wish to have all of your
previous data in Bandit to check for recaptures, etc., but you should be sure to complete all
of the import processes prior to entering new data. Remember to choose Show All Records

from the Records menu to see all of your records.

Once the data submission email is received by the BBL/BBO, an email response is returned, usually by
the end of the next business day. If you do not receive a response, it is likely that the data file was not
received. Check within your email program to see if the email is still pending.
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Chapter 8. Find Mode
Find mode may be used to search for particular records that match a set of criteria. You can then work
with this subset of your records, called the found set. To make a find request:

1. Go to the screen that has fields in which you want to enter criteria: Bands, Recaptures, or Band
Inventory.

2. Choose Find Mode from the View menu at the top of the screen or use CTRL-f (CMD-f on the Mac).
You may also click the small magnifying glass icon in the status area on the left side of your screen.
There are 4 icons just below the word Browse near the top left of your screen just under the menu bar.
The magnifying glass is the second icon in this row.

Figure 8.1. Bandit Mode Icon Bar

3. Enter your criteria into any fields to be used for finding records. The more fields you fill in, the more you
narrow down your found set. For example, you may just fill in a value for species. This will return all
records for that species. If you fill in both species and age, it will return all records for just that species
and that age. You can use operators such as greater than, less than, etc. in your searches. Available
operators can be seen and selected by right-clicking in the field and selecting Symbols from the drop-
down menu or using the Symbols drop-down located in the status area on the left side of your screen.
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Figure 8.2. Find Mode Symbols Drop-down Menu

4. Once you have entered all the criteria you wish to include in the search, press the Enter key (Return
key on the Mac) or click the Find button on the status area on the left side of your screen.

After you find a group of records, Bandit returns to Browse mode so you can begin working with them.
To show all records again, choose Show All Records from the Records menu or click the Show All button
in the Filter By section near the bottom center of the screen. If you are going to perform another find that
involves changing some, but not all of the criteria from your previous find, you can choose Modify Last

Find from the Records menu. This will bring up the find criteria from your previous search and you can
change or add any fields you wish for a new search.

Tip

Find mode can be used to create a custom Banding Summary by Location report. First select a
collection of bands using the process described above and then select the Banding Summary
by Location report from the Report Name drop-down menu. You will get a custom report with
just those bands you selected.
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Chapter 9. Reports
All of the reports in Bandit are available from the Bands section. Pick the report you want from the Report

Name drop-down menu and click the Show/Print Report button. A new window will appear where you can
preview the report. Use the book icon on the navigation and status panel on the left side of the window to
look through the pages of the report. A small dialog box will also appear with 3 checkbox options: Export

to Excel, Save as PDF, and Print. You can select any or all of these options. Then click OK to complete the
process or click Cancel to cancel the process.

Figure 9.1. Bands Screen with Reports Drop-down

The following reports are available in Bandit.

Report Name Use

Banding Data to be Submitted Similar to the Schedule produced from Band Manager. This
report must be produced before the submission process.

Banding Summary by Location Summary report grouped by location showing the number of
birds of each species, age, and sex combination banded at
that location. Use the filter function or the find mode before
requesting the report to select a subset of all the records to be
used for this report.

By Bander: Count Birds Handled per
Year

Summary report showing how many birds have been handled
by each bander.

By Location: Banding Data to be
Submitted

Similar to the Schedule produced from Band Manager, with
the information divided by banding location. This report must
be produced before the submission process.
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Report Name Use

By Species: Count Bandings by record
type

Summary report divided by species showing how many birds
were banded, recaptured, etc.

By Species: Count Bandings Per Day Summary report divided by species showing how many birds
were banded each day over a range of dates.

By Species: Count Bandings Per Month Summary report divided by species showing how many birds
were banded each month over a range of dates.

By Species: Count Bandings Per Year Summary report divided by species showing how many birds
were banded each year over a range of dates.

By Species: Count Birds by Age and Sex Summary report divided by species showing how many birds
of each age and sex combination are being maintained in the
inventory.

Summary of Bandings per Location by
Date

Summary report showing the banding activity for each location
over a range of dates.

Last Note For File (Bands) The last Note for File submission report created during the
submission process is available under this selection, provided
you asked to create the Note for File at the time of submission.

Unused Bands Removed A report showing the list of bands removed via the Remove
Unused Bands from Inventory function.
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Chapter 10. Reference Tables
Bandit uses a variety of reference tables to facilitate data entry and aid in the error checking process. The
reference tables are part of the data, rather than being part of the program code, making updates both
possible and straightforward.

Figure 10.1. Bandit Reference Tables Screen

To see what is contained in any of the reference tables, click on the Reference tab at the top of the screen.
Here is a list of the reference tables and their use.

Age Bird age codes and meanings. Both alpha and numeric codes are given.
Used in the drop-down lists for age data entry and error checking.

Color List of color codes and their meanings, for use with auxiliary markings.

Disposition List of banding and recapture record disposition codes and their
meanings.

How Aged List of how aged codes and their meanings.

How Sexed List of the how sexed codes and their meanings.

Present Condition List of the codes and their meanings for the condition of a recaptured
bird when it was released.
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Region Region codes and their equivalent meanings for geographic regions.
The region codes are being phased out in favor of using the Federal
Information Processing Standard (FIPS) codes for country, state/
province/territory, and county/parish/district.

Sex Bird sex codes and meanings. Both alpha and numeric codes are given.
Used in the drop-down lists for sex data entry and error checking.

Size List of band sizes. Refer to the Species tab to see which band sizes are
allowable on which species of bird. Used in the drop-down list for band
sizes.

Species Bird species alpha codes, numeric species ids, names, and allowable
band sizes. Used in the drop-down list for species and for error checking.
Because this list is lengthy, it includes a search facility.

Species-Age-Sex-Month Months or fractions of months a particular species, age of bird, and sex
of bird combination is likely to be encountered.

Species-State-Month Months or fractions of months a particular species is likely to be
encountered within a particular state/province/territory or country.

Status Combination of the bird status and additional information fields. Lists
status code and a longer description. Because this list is lengthy, it
includes a search facility

Type List of the types of bands that may be used. Used in the drop-down list
for band types.
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Chapter 11. Importing and Exporting
The ability to transfer data between Bandit and other programs such as Excel and SAS is an important
part of successfully integrating Bandit into your work processes. These capabilities have been enhanced
in the current version of Bandit.

Tip

Data quality checking constraints inside Bandit suggest the use of an ordered import
sequence. Bands must be added into your inventory before banding data can be imported.
Likewise, banding location data must be imported or created before banding data is imported
to avoid location errors. Finally, bander information must be available before banding data is
imported to avoid bander identification errors. Importing in this order: inventory, locations,
bander information, and importing bands last will ensure that data is consistent.

11.1. Importing from Band Manager
You can import four kinds of records from Band Manager: Band Inventory, Banding Locations, Banders,
and Bands. The first step is to use the export facilities of Band Manager to export the data in each of
these four areas. Export the files to a location on your hard drive or removable storage device that you
will be able to easily locate later, and be sure to give the files meaningful names so you know what each
of the files contains. Most often, it will be easiest to export them into the Band Manager Export folder.
When exporting files from Band Manager for future importing into Bandit, it is best to select dbf as the
file type for export in Band Manager. However, if you have user-defined fields, Excel is the preferred file
type for the export.

Imports for all four kinds of records from Band Manager can be done by selecting the appropriate Import

item located in the File menu. For each kind of record, the process is the same: find the file containing the
records you exported from Band Manager, verify that the fields from the import file match the fields in
the Bandit record, and click the Import button. Bandit will automatically verify the data from the import
file and incorporate it into the Bandit data file. In addition to Import from Band Manager, Bandit provides
the capability to import bandings, locations, and bander information from a variety of other types of files.
For more information, see Section 11.2, “Importing from Other Sources”, below.

11.1.1. Importing Band Inventory from Band Manager
Begin the process by exporting your inventory in Band Manager as a dbf (dBase IV) file into the Band
Manager Export folder and be sure to name it as something you will remember. Also check the box in
Band Manager at the bottom of the Export screen for the No. of Bands and note that number. Switch to

Bandit and click on the File menu and then select Import from Band Manager → Band Inventory from the
submenu. A dialog box will appear asking you to locate the file containing the data you exported from
Band Manager. Navigate to the Band Manager Export folder and click on the inventory file you exported
from Band Manager and wish to import into Bandit. A results box will appear telling you how many bands
were successfully imported as well as the number of spans added to your inventory. Ensure that the total
number of bands that were imported matches the number of bands shown on the inventory Export screen
as mentioned above. This will ensure that you successfully exported all of your bands from Band Manager
and imported them into Bandit.

Warning

Import Inventory from Band Manager may take a long time if you have a large number of
bands. The process is fairly quick (minutes) for less than 10,000 bands but may take some
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time (hours) if your inventory in Band Manager is extensive, particularly in the 100,000 band
range. Do not interrupt this process. After the import has started, clicking anywhere else in
the program will interrupt it. Interrupting the import process will result in erroneous records
being entered into the band number field and the only way to correct this is to reload the
program.

11.1.2. Importing Locations from Band Manager
Begin the process by opening Band Manager and navigating to the export function for locations by clicking
this sequence of buttons: Utilities, Program Lookups, Locations, Export. Your locations table will open.
Select dBase IV as the format and export the locations table to the Export folder by clicking on Export.

Switch to Bandit and click on the File menu and then select Import from Band Manager → Locations. A
dialog box will appear asking you to locate the file containing the data you exported from Band Manager.
Navigate to the Band Manager Export folder and click on the locations file you exported from Band
Manager and wish to import into Bandit. An Import Field Mapping box will appear. About 2/3 of the way
down the window on the right side, just at the top of the gray area, there will be an Arrange By drop-down
list. Select Matching Names from the drop-down list if it is not already there and then click the Import

button at the bottom right of the window. An Import Summary box will appear showing you how many
locations were successfully imported. Make sure this is the same number of locations you had in Band
Manager. Click OK. An Import Locations Result box will appear showing you how many locations were
added to the Bandit locations table. Click OK. The locations will now be in your table, added to the bottom
if you already had locations entered into the table. You must now add the counties to the table to get the
Valid? column to say Yes. County is required in Bandit for U.S. locations. The locations table is located
by clicking the Settings section button and then the Locations tab.

11.1.3. Importing Bander Information from Band
Manager

Begin the process by opening Band Manager and navigating to the export function by clicking this
sequence of buttons: Utilities, Program Lookups, Banders, and Export. Once again, select dBase IV as the
appropriate format and click Export. Name the file and save it in the Band Manager Export folder. Switch

to Bandit and click on the File menu and then select Import from Band Manager → Banders. A dialog box
will appear asking you to locate the file containing the data you exported from Band Manager. Navigate to
the Band Manager Export folder and click on the banders file you exported from Band Manager and wish
to import into Bandit. An Import Field Mapping box will appear. About 2/3 of the way down the window on
the right side, just at the top of the gray area, there will be an Arrange By drop-down list. Select Matching
Names from the drop-down list if it is not already there and then click the Import button at the bottom right
of the window. An Import Summary box will appear showing you how many banders were successfully
imported. Make sure this is the same number of banders you had in Band Manager. Click OK. An Import

Banders Result box will appear showing you how many banders were actually added to the Bandit bander
information table. Click OK. The banders will now be in your table, added to the bottom if you already had
banders entered into the table. You can now add the email addresses and phone numbers for sub banders
by clicking in the appropriate fields on the banders information table. The banders information table is
located by clicking the Settings section button and then the Bander Info tab.

11.1.4. Importing Banding Records from Band Manager
Begin the process by opening Band Manager and selecting the file containing the banding records you
wish to import into Bandit. Open that file and then click Export and go through the Band Manager export
fields process. Select the dBase IV format and click Export. Name the file and save it in the Band Manager

Export folder. Switch to Bandit and click on the File menu and then select Import from Band Manager →
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Bands. A dialog box will appear asking you to locate the file containing the data you exported from Band
Manager. Navigate to the Band Manager Export folder and click on the banding records file you exported
from Band Manager and wish to import into Bandit. An Import Field Mapping box will appear. About 2/3
of the way down the window on the right side, just at the top of the gray area, there will be an Arrange By

drop-down list. Select Matching Names from the drop-down list if it is not already there and then click the
Import button at the bottom right of the window. An Import Summary box will appear showing you how
many bands were successfully imported. Make sure this is the same number of bands you had in Band
Manager. Click OK. An Import Banders Result box will appear showing you how many band records were
actually assimulated into the Bandit banding records table. Click OK.

11.2. Importing from Other Sources
Banders who have never used Band Manager, but maintain files in other formats, such as Excel, Access,
SQL Server, dBase, etc. can also import data into Bandit if they wish to do so. In the File menu, choose
Load Data From File. It is recommended that, when the data are exported from the other program, they be
in tab-delimited (.tab), comma-delimited (.csv), Excel spreadsheet (.xls), or dBase (.dbf) format.

Figure 11.1. Import Data from File

After the Import Data From File choice is made, choose the file and note that a Field Mapping screen appears.
In the Arrange By box, the recommended choice is matching names, but this option will not work unless
you have already named your fields to match those in Bandit. For fields that do not match, click and drag
the target fields up or down, using the double-sided arrow icon, to match the data you see from the source
fields on the left. You must also make sure that any field you want to import has a thick arrow, not a thin
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line connecting from the source side to the target side. If the data you are importing has headings in the
first row, you should click the option Don’t import first record at the bottom of the screen.

Figure 11.2. Import Field Mapping Screen

When using this import option, it is important to note that the band number can be separated into two fields:
prefix and suffix or together in one field. Also, the date can be expressed as one field or three separate
fields. The Field Mapping screen allows for either option. If Band Number is in one field it can include
a dash between prefix and suffix or not.

Tip

In Excel, numbers with dashes have the advantage that the leading zeros are maintained on
3-digit prefixes. If you have your data in separate fields or don’t want to use dashes, put an
apostrophe (single quote) in front of the band number to tell Excel to treat the value as text
rather than as a number.

Tip

Dates can be imported as either 3 separate fields: month, day, and year, or as one combined
field. If you are using one combined field, put the fields in the order month, then day, then
year, and separate the parts with either slashes '/', dashes '-', dots '.', or semicolons ';' (but you
must use the same separator character in both places). Either two- or four-digit years can be
input, but note the following: two-digit year dates are converted into four-digit year dates
based on the year in which the date is entered into Bandit, with the assumption that the four-
digit year date should be in either the next 30 years, or the preceding 70 years.
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11.3. Exporting from Bandit
Bandit has several ways of exporting data. You can export data to Adobe Portable Document Format
(PDF), Microsoft Excel Worksheet format, or a variety of other formats, including tab-delimited text,
comma-delimited text, SYLK, DBF, HTML Table, and XML.

Note

Microsoft Excel has a limit of 65,536 rows. If you choose the Microsoft Excel Worksheet
(.xls) format for export, only the first 65,536 records will be exported.

11.3.1. Exporting Bands, Band Inventory, Banders,
Locations and Recapture Records

To export bands from Bandit go to the File menu. Then go to the Export Into File submenu and select Bands.
A dialog box will appear asking you to name the file you want to export the records to, where you want to
put the file, and the type of file you want to create. When you click Save (or just press Enter) a new dialog
box will appear allowing you to select the fields you want to export and the order in which you want them
to appear in the exported file. A number of fields have already been selected and will appear in the box
labelled Field export order. You can select additional fields from the list on the left and click Move to add
it to the Field export order box, click a field in the Field export order box and click Clear to remove the field
from the export list, or click and drag up and down with your cursor on the little double-pointed arrow icon
to move the fields up or down in the Field export order box. Finally, click Export to complete the operation.

Use a similar procedure to export band inventory, banders, locations, and recaptures. Each of these items
appears under the Export Into File submenu under the Files menu. To export band inventory go to the File

menu. Then go to the Export Into File submenu and select Band Inventory. To export banders go to the File

menu. Then go to the Export Into File submenu and select Banders. To export locations go to the File menu.
Then go to the Export Into File submenu and select Locations. To export recaptures go to the File menu.
Then go to the Export Into File submenu and select Recaptures.

Tip

Bander information, banding locations, and wing and weight data can also be exported
directly from the tabbed screens associated with each of these collections in the Settings
section. See Chapter 3, Bandit Settings.

11.3.2. Exporting Reference Tables
To export reference tables go to the tab page with the reference table you want to export. Then click the
Export button in the upper left hand corner of the screen. Enter in the file name and select the file type. Tab-
separated Text Files (*.tab), comma-separated Text Files and Excel Files (*.xls) are the most common.



47

Appendix A. Tips and Shortcuts
On the Bands and Recaptures screens (both Details and Table data entry modes) you can duplicate the
contents of the current record into the next record by selecting Duplicate from the Records menu or using
the keyboard shortcut (Windows: CTRL-d; Macintosh: CMD-d).

To duplicate (ditto) the contents of a field from the same field in the previous record, type Windows:
CTRL-' (single quote mark); Macintosh: CMD-' (single quote mark). Add the shift key (Windows: SHIFT-
CTRL-' (single quote mark); Macintosh: SHIFT-CMD-' (single quote mark)) to do the duplicate (ditto)
and automatically tab to the next field.

To enter today’s date, type Windows: CTRL-(dash); Macintosh: CMD-(dash).

To enter the current time, type Windows: CTRL-(semicolon); Macintosh: CMD-(semicolon).

To go to the next record, type CTRL-(down arrow). To go to the previous record, type Windows: CTRL-
(up arrow).

To go to the first field in the record, type Windows: CTRL-(left arrow); Macintosh: CMD-(left arrow).

To go to the next field, type Tab. To go to the previous field, type Shift-Tab.

To enter Find mode, type Windows: CTRL-f; Macintosh: CMD-f. To enter Browse mode, type Windows:
CTRL-b; Macintosh: CMD-b.

To copy all of the records to the clipboard, hold down ALT-SHIFT (OPT-SHIFT on the Macintosh) and
select Copy from the Edit menu. Then go to another application, like Word or Excel, set an insertion point
and select Paste.
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Appendix B. Bandit Band Record
Within Bandit, the Band Record is the primary place where data is stored about a banding. Although many
of the fields contain primary information about banding, some of the fields are used for error checking. In
this Appendix, only the fields of general interest to banders will be described.

Additional Errors Additional error text associated with the banding record.

Age User-visible age code in either alpha or numeric form, depending
on the setting in the preference section.

Age Code1 Numeric age code equivalent of the Age field.

AOU1 Numeric species id based on the 4-digit numbering scheme
originally developed by the American Ornithologists’ Union.

Aux Marker Band Color The code referencing the color of the auxiliary marker band.

Aux Marker Code The alphanumeric string imprinted on the band.

Aux Marker Code Color The code referencing the color of the alphanumeric string imprinted
on the band.

Aux Marker Combined1 A calculated field combining all of the given auxiliary marker-
related fields.

Aux Marker Type The type of auxiliary marker used on the bird.

Band Number Calculated version of the band number containing the prefix, a dash,
and the suffix.

Band Size Coded size of the band.

Bander ID Identifier for the bander who handled this bird. If this was an official
sub-bander, this should be the sub-bander ID.

Banding Date1 Date the bird was banded.

Bill Height Height in millimeters of the bill.

Bill Length Length in millimeters of the bill.

Bill Width Width in millimeters of the bill.

Bird Status1 The 3-digit code indicating the status of the bird after the banding
operation was completed.

Bird Weight The weight in grams (mass) of the bird at the time it was captured.

Body Molt Whether or not body molt was observed.

Brood Patch Presence and size of the brood patch.

Capture Time Time of day the bird was captured.

Cloacal Protuberance Presence and size of the cloacal protuberance.
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Culmen Length Length in millimeters of the culmen.

Date Received Date the band was received.

Disposition1 Code indicating what happened to the band.

Errors Error text associated with the banding record.

Ectoparasites Whether or not ectoparasites were present on the bird.

Eye Color Color of the eyes of the bird.

Fat Score Amount of migratory fat found on the bird, using a scale of 1-6.

How Aged1 Code indicating how the age of the bird was determined.

How Captured Code indicating how the bird was captured.

How Sexed1 Code indicating the method used to determine the sex of the bird.

Left Leg Color 1 Color of the 1st auxiliary marker on the left leg for non-coded
markers.

Left Leg Color 2 Color of the 2nd auxiliary marker on the left leg for non-coded
markers.

Left Leg Color 3 Color of the 3rd auxiliary marker on the left leg for non-coded
markers.

Net Nest Cavity Designator How (or from where) the bird was captured. Could be Mist Net,
Nest, Box, etc.

Net Nest Cavity Number Specific location where bird was captured from.

Prefix1 The 4-digit prefix of the band number. The value has leading zeros
if necessary.

Present Condition The condition of the bird.

Right Leg Color 1 Color of the 1st auxiliary marker on the right leg for non-coded
markers.

Right Leg Color 2 Color of the 2nd auxiliary marker on the right leg for non-coded
markers.

Right Leg Color 3 Color of the 3rd auxiliary marker on the right leg for non-coded
markers.

Remarks1 Free-form text for remarks relating to this bird. May indicate
additional information about aux markers, methods used, etc. Only
the first 100 characters of the remarks are included in the data
submission.

Replaced Band Number1 If the band is a replacement band or an additional band put on a
bird, this field contains the band number of the original band.

Reward Band Number1 5- or 6-digit reward band number.
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Scribe Initials or reference to the person writing down information at the
banding site.

Sex The sex of the bird in coded form. Can be either alpha or numeric
code, depending on what the user requested in preferences.

Sex Code1 Numeric version of the sex of the bird.

Skull Degree of skull pneumatization.

Species1 The 4-letter or 4-digit code representing the species of the bird in
either alpha or numeric format, depending on the preference set by
the user.

Species Name The name of the species of the bird.

Submission Date The date the banding record was (last) submitted.

Suffix1 The 5-digit suffix of the band number. This number has leading
zeros, if necessary. The 5 digits of the band number stored here are
actually the last 5 digits of what is really a 6-digit suffix.

Tail Length Length in millimeters of the tail of the bird.

Tarsus Length Length in millimeters of the tarsus of the bird.

Tests Performed The tests that were performed on the bird.

Weight Time The time of day the bird was weighted, including hours and
minutes, using the 24-hour clock.

Wing Chord The length in millimeters of the wing chord of the bird.



51

Appendix C. Data Editing Error
Messages

The table below lists all of the errors flagged by Bandit as it edits the data, along with an explanation of the
cause of the error and the suggested way to fix it. Many of the edits apply to banding and recapture records,
so these errors are grouped together. Errors associated with banding locations are grouped separately.

Error Message Cause Resolution

Banding and Recapture Data

Age/Sex unlikely on this
date

Species-Age-Sex-Month combination
invalid.

See Species-Age-Sex-Month table for
valid combinations. May be bypassed
with remarks.

Bad Recapture Sex VS
Banded Sex

Sex should correspond on banding
and recapture records.

Verify sex of recaptured bird.

Bad Recapture Species
VS Banded Species

Species are not the same for same
band number.

Verify recapture band number; Verify
species.

Bad Size Species is not supposed to wear this
size of band.

Go to species reference table to see
the list of appropriate sizes. May be
bypassed with an explanatory remark.

Band Found in Bands
Inventory. Incorrect
disposition code used

Disposition code is set to F while the
banding record is in inventory.

Set disposition code to R or verify
band number.

Band Not Found in
Bands Inventory. Make
sure this is not a foreign
recapture

Disposition code is set to R and the
banding record is not in inventory.

Verify disposition code. May be
bypassed.

Duplicated band number This band number already exists. Fix band number.

Invalid Band Number Not numeric band number or Band
Number Length is not equal to 9.

Fix band number (prefix and suffix).

Invalid Banding Date Banding Date greater than Current
Date or Banding Date less than Date
Received.

Make sure Received Date in band
inventory is set to proper value.
Verify banding date.

Invalid Bird Status VS
Tests Performed

If Bird Status indicates blood sample
was taken, Test Performed needs to
reflect this (and vice versa.)

Make sure bird status reflects test
performed information.

Invalid Color(s) Color of markers or Color of Code
are not correctly coded.

Choose appropriate colors from
associated drop-down lists.

Invalid How Aged code How Aged value is not in the list of
values.

Make sure the How Aged field is
either empty or contains a value from
the drop-down list.

Invalid How Sexed code How Sexed value is not in the list of
values.

Make sure the How Sexed field is
either empty or contains a value from
the drop-down list.

Invalid Marker Type Marker Type is not correctly coded. Choos Marker Type from drop-down.
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Error Message Cause Resolution

Invalid Recapture Date Recapture Date greater than Current
Date or is empty.

Verify recapture date.

Invalid Recapture Date
VS Date Received

Recapture Date less than Date
Received.

Verify recapture date.

Invalid Replaced Band
Number

If Disposition code is 5, 6, S, or D,
Replaced or Second Band Number
has to be reported, and the length of
this number must be 9. Otherwise this
field has to be empty.

Verify disposition and replaced band
number fields.

Invalid Reward Band
Number

If Status indicates this is a reward
band, the length of Reward Band has
to be 5 or 6.

Verify status and reward band fields.

Invalid Species Species is not entered or is not in the
species list.

Verify species.

Invalid Status VS
Disposition Code

If this bird has been double banded
(Disposition code D or S,) Status
needs to reflect this.

Verify disposition and bird status.

Invalid Status VS How
Sexed

How Sexed is L (laparotomy or
laparoscopy) but Status does not
reflect this.

Status code must end with 11, 12, or
85 if laparotomy or laparoscopy was
done.

Invalid Status VS
Marker Type Code

Bird status needs to correspond to
Aux Marker Type.

Verify Status and Aux Marker Type
fields.

Location used is not
valid or Invalid Location

Location is empty or not verified. Make sure Location field is not
empty. Go to Settings screen,
Locations tab. Verify location
information. Valid column has to be
Yes. (Hint: Put your cursor over any
No value to see what the errors are.)

Recapture date before
banded

Banding date is greater than recapture
date.

Verify dates.

Same-day recapture
record

This bird was already entered into the
system as recaptured on this date.

If appropriate, delete one of the
recapture records.

Species unlikely in state Species-Region combination
questionable.

See Species-State-Month reference
table for valid combinations. May be
bypassed with remarks.

Species unlikely on date Species-Month combination
questionable.

See Species-State-Month reference
table for valid combinations. May be
bypassed with remarks.

Status code requires
remarks

Remarks field is empty but the status
code entered requires an explanation
in the remarks field.

Add appropriate information to the
remarks field. See the BBL web site
http://www.pwrc.usgs.gov/BBL/
manual/status.htm for details. (Status
codes ending with 25 and 29 require
a marker type to be entered in the
remarks field. Status codes ending
with 06 or 85, or codes starting with
5, 7, or 8 require an explanation to be
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Error Message Cause Resolution

entered in the remarks field. Status
codes starting with 2 require capture
location and date to be entered in the
remarks field.)

Undefined Age or
Invalid Age

Age is empty or not in the code list. Choose an Age from the drop-down
list.

Undefined Bird Status Bird Status is empty. Set Bird Status field from the choices
in the drop-down list.

Undefined Record Type Disposition code is empty or invalid. Choose a Disposition code from the
drop-down list.

Undefined Sex or
Invalid Sex

Sex is empty or not in the code list. Choose a Sex code from the drop-
down list.

Location Data

Invalid coordinates VS
Region

Coordinates provided do not
correspond to Country/State
combination

Verify Latitude/Longitude and
Country/State.

Invalid Country Country is empty or invalid. Choose a Country from the drop-
down list.

Invalid County US locations must have a county
entered.

Choose a County from the drop-down
list.

Invalid Description Location Description is empty. Enter a short description for this
location.

Invalid Direction Hemisphere values are incorrect. Verify the hemisphere fields for both
Latitude and Longitude.

Invalid Lat Latitude degrees must be in the range
0-90. Minutes and seconds must be in
the range 0-59.

Verify Latitude (Deg, Min, Sec).

Invalid Lat Hem Latitude hemisphere must be N
(North) or S (South).

Choose Latitude Hemisphere from
the drop-down list.

Invalid Location ID Location ID is empty, not unique, or
length is greater than 8 characters.

Set Location ID to correct value.

Invalid Location
Precision

Location Precision is empty or
invalid.

Choose Location Precision from the
drop-down list.

Invalid Long Longitude degrees must be in the
range from 0 to 180. Minutes and
seconds must be in the range 0-59.

Verify Longitude (Deg, Min, Sec).

Invalid Long Hem Longitude hemisphere must be E
(East) or W (West).

Choose Longitude Hemisphere from
the drop-down list.

Invalid Minutes Latitude and longitude minutes must
be in the range 0 to 59.

Verify Minutes.

Invalid Region Bandit is unable to find the region
code based on Country/State
provided.

Verify the Country and State fields.

Invalid Seconds Latitude and longitude seconds must
be in the range 0 to 59.

Verify seconds.
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Error Message Cause Resolution

Invalid State US and Canada locations must have
State entered.

Choose State from the drop-down list.

Minutes/Seconds do not
correspond to the center
of 1 degree block

If Location Precision is 60, minutes
must be 30 and seconds must be 00.

Verify Minutes and Seconds or
change Location Precision.

Minutes/Seconds do not
correspond to the center
of 10 minute block

If Location Precision is 10, minutes
must be 05, 15, 25, 35, 45, or 55 and
seconds must be 00.

Verify Minutes and Seconds or
change Location Precision.

Negative Lat Deg Negative value in location latitude
degrees field.

Fix Latitude Dec field. (Hint: Set the
hemisphere to E (East) or W (West)
in the field following seconds.)

Negative Lat Min Negative value in location latitude
minutes field.

Fix Latitude Min field.

Negative Lat Sec Negative value in location latitude
seconds field.

Fix Latitude Sec field.

Negative Long Deg Negative value in location longitude
degrees field.

Fix Longitude Dec field. (Hint:
Set the hemisphere to E (East) or
W (West) in the field following
seconds.)

Negative Long Min Negative value in location longitude
minutes field.

Fix Longitude Min field.

Negative Long Sec Negative value in location longitude
seconds field.

Fix Longitude Sec field.

Not Numeric Lat Deg Invalid character in latitude degrees
field.

Latitude Deg field must be numeric.

Not Numeric Lat Min Invalid character in latitude minutes
field.

Latitude Min field must be numeric.

Not Numeric Lat Sec Invalid character in latitude seconds
field.

Latitude Sec field must be numeric.

Not Numeric Long Deg Invalid character in longitude degrees
field.

Longitude Deg field must be numeric.

Not Numeric Long Min Invalid character in longitude minutes
field.

Longitude Min field must be numeric.

Not Numeric Long Sec Invalid character in longitude seconds
field.

Longitude Sec field must be numeric.

Seconds do not
correspond to the center
of 1 minute block

If Location Precision is 1, seconds
must be 30.

Verify Seconds or change Location
Precision.
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Appendix D. Alert Messages
The table below lists all of the pop-up alert messages displayed by Bandit along with the circumstance
in which the message appears.

Error Message Cause 

Band Inventory

Not all required fields are entered. Please enter all
the fields.

When entering band spans into inventory, you must
enter band number prefix, starting suffix, ending
suffix, and band size.

One or more bands are already in the file for the
range you specified. Please recheck your values.

When entering band spans into inventory, the band
number range cannot include bands that are already
in the file.

There are no unused bands in this span. Nothing to
remove.

If you try to use the Records menu function Remove

Unused Bands from Inventory Record on a span in
the inventory that does not have unused bands you
will see this message. Make sure your cursor is on
the correct span before selecting this function. (The
column Unused Quantity shows how many bands in
the span are unused.)

Locations

An error occurred while trying to add this location.
Location IDs must be unique.

Every location must have a unique identifier
associated with it. The identifier can be up to
8 characters long. The identifier is used on the
banding record to refer back to the location.

The location x can not be deleted because there are
x bands with this location.

In the Locations screen, check the value in the
column Bands Count. If there is a non-zero value
here, you cannot delete the location because there
are banding records which reference this location.
Make sure your cursor is on the correct location
before trying to delete a location.

Bands

There are no band records which match the filter
request.

The filtering criteria you specified did not select any
records. Look at all the possibilities in the filtering
criteria and change it to match the records you want
to see.

No band record to duplicate to. The Duplicate Record function takes the values from
the current record and copies them into the next
record. If there is no next record, you will see this
message.

Second Band x has been filled previously. Do you
want to overwrite existing record?

For double-banded 1st band and double-banded 2nd
band, if the record associated with the second band
is already filled in, you will get this message. This is
just a warning so you do not inadvertently overwrite
previously entered data.

Second Band x not found. Please, provide correct
second band number, or if it is correct, go to band

For a double-banded bird (disposition code D or S,)
both the 1st band number and the 2nd band number
must be in your inventory. If you meant to add an
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Error Message Cause 

inventory and add the corresponding span in to the
system.

additional band, use disposition code 6. If this is a
replacement band, use disposition code 5.

Invalid Second Band Number. The value in the Second Band Number field is not a
valid band number.

Current Band x and Second Band x are the same.
Please correct second band number.

The value in the Second Band Number field is not a
valid band number.

Band x has status x. Recapture may not be reported
for this band.

The status of the band (as indicated in the Disposition

field) is undefined or indicates that the band (or
record of the band) was lost or destroyed. You
cannot report a recapture by clicking the Report

Recapture button. (You may, however, add the
recapture through the Add Recapture button on the
Recaptures screen.)

Data Submission

Permit number is not defined. Please go to Settings:
Bander Info, and define permit number

Your permit number must be entered on the Settings

screen before data submission can occur.

The country where submission has to be sent is not
defined.

The country of submission (Canada or US) must
be selected on the Settings screen before data
submission can occur.

No valid data was found to be submitted. The submission process only submits banding
records which are either new or have changed since
the last submission. Further, the records have to
be error free before they can be submitted. Some
errors can be bypassed, but you must select the
Bypass Errors option on the banding record. Prior to
submitting data, it is a good idea to use the Banding
Data to be Submitted report (or the By Location:
Banding Data to be Submitted report) to see what
data will be submitted.

Recaptures

There are no recapture records which match the
filter request.

The filtering criteria you specified did not select any
records. Look at all the possibilities in the filtering
criteria and change it to match the records you want
to see.

Reports

No records found for this report. The report cannot be produced because there is no
data availble for this report.

Importing

This process may take a long time, please let it finish
(you may want to run it during night). Alert - no
edits will be performed on inventory records. No
duplicated records will be loaded. If you are not
sure if data is valid, you better use Add to Inventory
function instead.

This warning message appears when the File →
Import from Band Manager → Band Inventory menu
item is selected.

Import Band Inventory Error: Band x already exists
in inventory. Cannot import this band.

Duplicate records are not allowed in the band
inventory.
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Error Message Cause 

Miscellaneous

Function is under construction. May appear when a capability has been partially
implemented.

Program Expiration: This version of Bandit 0.x has
expired. Contact the USGS Bird Banding Lab for a
new version.

Your version of Bandit is an old version. The new
versions do not expire.
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Appendix E. Frequently Asked
Questions about Bandit

Q: How do I import banding data with bands that have a 3-digit prefix?

A: Make sure the file you are importing has lead zeros. In Excel, you must put an apostrophe in front
of the number for the lead zero to stay.

Q: If I am importing a file from another program, must I have a dash in the band numbers?

A: No. Bandit with take the band number with or without dashes.

Q: When I download the Mac version, my computer says it doesn’t recognize the file Bandit_1.02.bin.
How do I proceed?

A: You need to either change the extension to .dmg or open it with Disk Utility.

Q: I am trying to install the program and I get a message saying “Error opening registry key, access
denied”. How do I proceed?

A: You need administrative access to install the program. Contact your I.T. support staff.

Q: My email program is not sending submission data automatically. What email address should I use
to submit my banding data?

A: <Bandit@usgs.gov> or <Louise.Laurin@ec.gc.ca> for Canadian Banding Office
submissions.

Q: I’m having trouble getting the program to work. Where do I go to get help?

A: Send an email request for help to the Bandit Help Desk, <BanditHelp@usgs.gov>, available
also from the Help menu or the opening screen. You can also call the Help desk at 301-497-5566.
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Appendix F. Release Notes
F.1. Version 2.0 (released 3/7/2008)

Version 2.0 was released March 7, 2008 and contains several new major features along with a significant
number of fixes, refinements and enhancements. A summary of the changes is given below, along with
references to the relevant sections containing more information, as appropriate.

1. Mark as Submitted and Mark as Not Submitted functions have been added to the Records menu on the

Bands and Inventory screens. On the Bands screen, Records → Mark as Submitted sets the submission

date and time to the current date and time for all records in found set. Use the Records → Mark as Not

Submitted function to remove the submission date and time from all records in the found set. On the

Inventory screen, Records → Mark as Submitted sets the submission date and time to the current date

and time for all banding records in the selected span, and Records → Mark as Not Submitted removes
the submission date and time from all records in the selected span.

2. Five all-purpose user-defined fields are available to store additional information associated with a band.
Define the fields on the Settings screen under the User Fields tab and add and edit the fields on the Bands

screen using either the User Fields tab on the Details view or the User Field 1, …User Field 5 columns
in the Table view.

3. Importing Banding and Recapture records is significantly faster in this version, and several options add
to the versatility of this function. If some of the incoming records are not found in inventory user has
three choices: cancel the import completely, ignore the band records missing from the inventory, or
save the missing records in separate file. If some of the incoming records are for records with banding
data already entered, user again has three choices: cancel the import, overwrite existing banding data,
or ignore the incoming record. Incoming Recaptures will automatically overwrite existing recaptures
with the same band number, recapture date, and capture time, or be added as new recapture records if
the band number, recapture date, or capture time is different. N.B.: More than 1 recapture per day may
be loaded (if the capture time is different).

4. A new report, Banding Summary by Location, has been added to the list of reports, showing banding
totals for each location, species, age, and sex combination. You may run this report on any subset of
banding records created using either the filter function or the Find mode. This found set should be
selected before the report is selected.

5. The Banding Data To Be Submitted and By Location: Banding Data To Be Submitted reports now show
all the records to be submitted, including records with errors, making it easier to identify and correct
errors. In the report, records with errors will be highlighted.

6. On the Bands screen, the filter notification message now shows filter status when using either the Filter

button or the Find mode. Also, the Filter button properly finds bands with 00000 suffixes.

7. The process of submitting banding data to the banding lab has been streamlined to make it faster, and
an option to allow reviewing and correcting records with errors makes the task even easier.

8. The data submission file is now encoded with Unicode, using the UTF-8 character set. Unicode
preserves language-specific accents and special characters, ensuring what you sent is what you meant.

9. As an additional aid in the process of editing fields to ensure high data quality, fields which may contain
errors are highlighted in yellow on the Bands Table and Detail screens and the Error Text field will be
highlighted if the record contains errors which cannot be bypassed.
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10.A new edit on the Bird Status field requires an explanatory remark to be added in the Remarks field if
the Bird Status field starts with 2, 5, 7, or 8.

11.A new code was added to both the How Aged and How Sexed drop-down lists:

Code Description

X Not attempted

12.Two new species were added:

Code Species Common Name

2561 Wood Sandpiper

2591 Gray-tailed Tattler

13.New band sizes were added for several species:

Code Species Common Name Sizes Added

3570 Merlin 3, 3B

1440 Wood Duck 5A

6220 Loggerhead Shrike 1D

3520 Bald Eagle 8A

2150 Yellow Rail 1A

1590 Common Eider 7B

14.The reference tables Species-age-sex-month and Species-area-month were reloaded with more recent
data.

15.Several changes in this version are associated with auxiliary markers. The Aux Marker tab on the Details

view of the Bands screen now shows translations of the codes. Edits for marker color and marker type
codes have been added to ensure the validity of the data in these fields. Also, the Is Aux Marker Coded?

columns and labels in bands, recaptures, and import tables are consistent. Finally, a message will appear
on the Bands Detail screen if the value entered in the Status field requires auxiliary marker information
as a reminder to visit the Aux Marker tab. The message will disappear once the data has been entered.

16.On the Location Settings screen, latitude and longitude coordinates (degrees, minutes, and seconds) are
edited to ensure they are numeric and non-negative. Instead of using a negative value in degrees to
indicated West longitudes and South latitudes, use the hemisphere drop-down lists, located adjacent to
the seconds fields for each coordinate.


